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Summary

HAWS (The HIV Algorithm Workflow System) is an application for managing
the workflow and data capture processes associated with HIV studies.

HAWS walks the user through a series of steps for a patient visit, collecting
assay results from the user, managing requests for specimen redraws, and
ultimately determining the final result of the testing work for the patient visit.
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Getting started with HAWS

This section will get you acquainted with HAWS.

What is HAWS?

HAWS (The HIV Algorithm Workflow System) is an application for managing
the workflow and data capture processes associated with HIV studies.

HAWS walks the user through a series of steps for a patient visit, collecting
assay results from the user, managing requests for specimen redraws, and
ultimately determining the final result of the testing work for the patient visit.

HAWS works by assigning algorithms to patient visits. Each algorithm
determines what specimens need to be tested and what assays need to be
run for the visit. Depending on the results of each assay, the algorithm may
assign additional assays to be run. In this way, HAWS acts like a flow chart,
guiding the user from a visit to a final result, helping them keep track of
individual results and the next step needed in the process.

HAWS also includes many other tools useful for completing HIV testing work,
such as the ability to generate final reports for several patient visits at once,

print listings of specimens to be tested along with their storage locations, and
the ability to interact with data stored in LDMS.

What are algorithms and workflows

An algorithm is the logic for processing a patient visit; a workflow is a visit
that is currently being processed by an algorithm.

Algorithms are defined by network leadership and implemented in HAWS by
Frontier Science. Users cannot create new algorithms, nor can they modify
existing algorithms. An algorithm may define such things as what assays need
to be run for certain specimen types. For example, if a visit included a blood
specimen, the algorithm would define what assay(s) needs to be run for that
specimen. Depending on the results of the assay, the algorithm may define
additional tests. This might happen, for example, if a specimen tested positive
and a second test is needed to confirm the positive result.

A workflow is an instance of an algorithm. When a user selects a visit to
process in HAWS, they select the algorithm to use and the workflow is
created. Thus you can create several workflows using the same algorithm.

Frontier Science Foundation 5
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Figure 1: Example algorithm and workflows based on it

Example Algorithm Workflows
BLD specimen Patient: 12345
l Visit: 2 VST
- Algorithm: Example
Run assay |—«4mm—{ Testagain
i Patient: 87654
Negative? Positive? Yes Visit: 2 VST
; Algorithm: Example
1% positive?

Patient: 15940
jNO Visit: 2 VST
Algorithm: Example

Result

An example algorithm (left) and workflows for patient visits using the logic from the algorithm (right).

While a workflow is active, HAWS will guide you to the text step in the
algorithm's logic automatically. Using the example, if a workflow orders a test
and the result is a positive, HAWS will automatically determine if this was the
first positive for the workflow and, if yes, automatically reassign the assay to
be run again.

LDMS and HAWS

HAWS will pull participant, visit, and specimen information from your LDMS
database. The sync to the LDMS database is configured by User Support upon
installation or upgrade.

Typically data from LDMS is populated in HAWS automatically and the process
will be transparent. If you do need to refresh data from LDMS manually, click
Tools > Refresh from LDMS from the HAWS menu bar.

Getting HAWS

HAWS will typically be installed by HAWS User Support. This is usually done
using a remote connection to your computer. Not only will HAWS User Support
install HAWS, they will also perform general configuration for you so that your
laboratory can start using HAWS right away.

HAWS User Support will ask you for specific information about your
laboratory, such as contact information and where you want files stored on
your server. This information will be used to initially configure HAWS. Most
of these settings can be updated later by your laboratory. A backup of the
database should occur prior to the upgrade to a new version or the re-install
of the database.

Frontier Science Foundation 6
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Getting help

HAWS User Support is available 24 hours per day, 7 days per week.

HAWS User Support can answer questions about using HAWS and, if
needed, connect remotely to your computer to assist with technical issues.
Additionally, a link to the user manual can be accessed from the Help menu.

HAWS User +1 716 834 0900 extension 7311
Support by
telephone

HAWS User haws@fstrf.org
Support by
email

More information and support resources are available on the LDMS website.

Supported assays

The following assays and kits are supported by HAWS.

Assays Supported kits

Abbott Prism Abbott Prism, Anti HIV-1/2

Bio-Rad Geenius HIV 1/2 Confirmation Assay Bio-Rad Geenius HIV 1/2 Confirmation
Assay

Alere Alere Determine HIV-1/2 Ag/Ab Combo

Alere HIV Combo
Determine HIV Early Detect
Determine HIV Early Detect (Non-CE)

DNA PCR Frozen Whole Blood DNA ddPCR assay
Roche Amplicor HIV-1

Roche COBAS AmpliPrep/TagMan HIV-1
Qualitative

Enzyme Immuno Assay Abbott Architect HIV Ag/Ab Combo
Abbott Axsym HIV Ag/Ab Combo

Abbott HIV-1/HIV-2 (rDNA)

Abbott Murex HIV-1.2.0

bioMerieux Vironostika HIV Ag/Ab HIV 1/2

bioMerieux Vironostika HIV Uni-Form II +
o

Bio-Rad Genetic Systems HIV 1/2 Plus O
Bio-Rad Genetic Systems rLAV

Bio-Rad GenScreen HIV 1/2

Bio-Rad Genscreen Ultra HIV Ag-Ab HIV

1/2

Bio-Rad GS HIV Combo Ag/Ab EIA

Toyo Anti-HIV 2

Frontier Science Foundation
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Assays

Supported kits

HIV-1 Total Nucleic Acid Assay

HIV-1 Total Nucleic Acid Assay

Multi-Spot Assay

Bio-Rad Multispot HIV-1/HIV-2 Rapid Test

OraQuick

OraQuick Rapid HIV-1 Antibody Test

RNA PCR

Abbott Alinity m HIV-1 RT-PCR

Abbott m200 RealTime PCR HIV-1

Roche Amplicor Monitor HIV-1 Standard
Ver 1.5

Roche Amplicor Monitor HIV-1
Ultrasensitive Ver 1.5

Roche Cobas 5800/6800/8800 System
HIV-1

Roche COBAS Amplicor Monitor HIV-1
Standard Ver 1.5, with COBAS AmpliPrep
Roche COBAS Amplicor Monitor HIV-1
Ultrasensitive Ver 1.5, with COBAS
AmpliPrep

Roche COBAS AmpliPrep/COBAS Tagman
HIV-1, Version 1.0

Roche COBAS AmpliPrep/COBAS Tagman
HIV-1, Version 2.0

UW Developed HIV-1 RNA Real-Time
RTPCR

UW Developed HIV-2 RNA PCR

SD Bioline

SD Bioline HIV-1/2 3.0

Western Blot Bio-Rad Genetic Systems HIV-1

Bio-Rad Genetic Systems HIV-1

Western Blot Bio-Rad New Lav Blot II

Bio-Rad New Lav Blot II

Related tasks
Creating a new run on page 28

Configuring HAWS

This section will describe the various configuration options and features

available in HAWS.

User management in HAWS

HAWS is user-based. In order to use HAWS, you must login using your own
unique user account. Your user account determines what you are permitted to
do in HAWS, and HAWS tracks what user completes certain actions.

Frontier Science Foundation
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Figure 2: The User Administration window

Users:

User name: |ADMIN P |
fabiola 2
ingebourg Full name: |Aa:|mini5tratnr u |

danielle

fabricia Initials: Change password...

flavia
User can approve results @

sandro
User can view and print reports

Mew user
@ Close

(1) existing users, (2) information for currently selected user, (3) permissions for currently selected user, (4) create a
new user

There are three types of permissions that users can have in HAWS:

Administrator An administrator can make changes to other user
accounts, create and inactivate users, and change
configuration settings in HAWS. The only setting that
administrators cannot change is their own status as an
administrator. This prevents users from accidentally
removing all administrators.

Can approve Users with this permission can complete the result
results algorithm task and approve assay results.

Can view and Users with this permission can generate final reports for
print reports workflows.

E] Note: Administrators don't inherently have the ability to approve
results and generate reports; these are separate concepts in HAWS.

HAWS User Support will typically create the necessary users for you when
installing HAWS. If no users were created for you, the default user is admin
with the password admin. To prevent users from logging in as the admin
account to complete normal work, the admin account should be set to inactive
once you have created at least one other system administrator.

Creating new users

E] Note: Creating, removing, and modifying other user accounts requires
= system administrator permissions. Non-system administrators can only
modify certain properties for their own user account.

Frontier Science Foundation 9
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[y

Click Tools > User Administration from the HAWS menu bar.
Click the New user button.
3. Enter the new user's user name into the User name text box.

The user name is not case sensitive. The user name must also be
unique among all users, including those that have already been

N

deleted.
4, Enter the new user's full name into the Full name text box.
5. Enter the new user's initials into the Initials text box.
6. Select any permissions that should be assigned to the user.
Option
system administrator Can create, modify, and remove
other users
Can approve results User can approve assay results
and complete the result algorithm
task
Can view and print reports User can complete the final report

task and print bulk reports

New users will have the same password as their user name by default. For
example, a user with the user name ROBERT will have the default password
robert (lower case).

The new user should change his or her password after logging in for the first
time. This is done by selecting Tools > User administration from the HAWS
menu bar, and then clicking the Change password button.

Modifying users

1. Click Tools > User Administration from the HAWS menu bar.
2. Select the user to modify from the list of users on the left.
3. Modify user information as needed.

e Regular users can only change their user name, full name, and
password

e Administrators can change user permissions

e Administrators can inactivate the selected users. Inactive users
cannot log on to HAWS, but will still be available for selection in
drop-down lists (e.g. selecting the technician for an assay run)

Frontier Science Foundation 10
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E] Note: While it is possible to delete users, it is recommended
that users be inactivated in case the user's account is needed
in the future.

4. After all changes are made, click the Save button.

Options window

The Options window allows the user to configure several general HAWS
settings. The Options window is accessed by clicking Tools > Options from
the HAWS menu bar.

E] Note: During installation, HAWS User Support will have configured
= these settings for you.

Figure 3: The Options window

(2) location where exports will be generated, (2) location where final workflow reports will be generated, (3) location
for HAWS log files, (4) location where backup files will be generated

Options m ot
Export base folder: | Matd-DEVWHAW S \Export V | Browse...
7N
Reports base folder: |C:'afstrf-DE‘-.-"'-.HN.".:'S'-.HepDrtst 2 j | Browse...
HAWS data folder: | C:stf-DEVAVHAWS Data 3 | Browse...
Search for samples not in storage
Automatically lock HAWS if idle for n minutes); |30 =4 [Mote: Use 0 to never lock]
Backup Settings I~
Folder (on server): |C:'-istrf-DE‘-.-"'-.HN.".n'S'-.Backup [ 5 J | Browse...
—
Retention days: B =
Cancel
The following settings can be changed in the Options window:
Export base This is the directory where SCHARP export files and
folder adjudication export files will be saved. Files will be placed
in sub-directories in the export base folder.
Reports base This is the directory where workflow reports will be
folder saved.
HAWS data This is the location where log files generated by HAWS
folder will be stored.

Frontier Science Foundation 11
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Search for If enabled, samples that have not been stored in the

samples not in LDMS Storage task will be displayed.

storage

Automatically This is the amount of time (in minutes) after which

lock HAWS if HAWS will automatically lock and require a user name

idle and password. To disable this feature, set this number to
0

Backup settings This is the directory on the HAWS server where
automatically generated backup files of HAWS data will
be created, as well as the number of days the backup
files will be retained. The oldest files will be deleted after
the set retention days (default: 7 days).

Note: Because the HAWS backup files are stored on the HAWS server,
it is important that you manually copy these files to a safe location that
is not on the HAWS server. It is recommended that you do this once per
week.

Related concepts
Backup management on page 22
Related tasks

Export reports on page 52
Export reports are tab-delimited text files that are intended to be sent to
SCHARP.

Creating unblinded EOS/EOX reports on page 51
Batch printing final reports on page 50

Protocol Administration

E] Note: Only users with system administrator privileges can access
= Protocol Administration.

The Protocol Administration window is used to manage what protocols and
patients are blinded and unblinded. Protocol administration is accessed by
clicking Tools > Protocol Administration from the HAWS menu bar.

Figure 4: The Protocol Administration window

(1) add/view/modify protocols, (2) add/view/modify unblinded patients, (3) add new protocol to HAWS, (4) modify
selected protocol, (5) list of protocols entered into HAWS

Frontier Science Foundation 12
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® Protocols  Patients @

Protocols:

- . Alows Uses
dLI:{I;hndlng Locked ,R&dejﬂglir::ﬁon Optional Monstandard ~ Comments

Adjudication  Patient 1D

__E_@_—

Study Unblinded

Delete

Add Edit
@ @ Close

For the evaluation of sero-reactivity (EOS), evaluation of sero-reactivity
recent exposure (EOX), and post-study (POS) algorithms, the final workflow
report can be generated as either blinded or unblinded. Here is how the two
versions differ:

e A blinded report shows the overall final workflow result, but does not
include individual test results.

e An unblinded report shows both the final workflow result and individual test
results.

The routine (VST) and recent exposure (EXP) algorithms always produce
blinded reports. The infected testing (INF) algorithm essentially produces an
unblinded report because it is a report of an individual RNA PCR test.

To determine whether an HIV Infection Status Report should be produced
as blinded or unblinded, HAWS checks whether the entire protocol has been
unblinded. If the entire protocol has not been unblinded, HAWS will check
if the specific Patient ID for this algorithm has been unblinded. If neither of
these are the case, then HAWS will produce a blinded report.

Changing protocol adjudication settings

1. On the Tools menu, click Protocol Administration.
2. Select the study to be modified, and then click Edit.
3. Modify the Requires adjudication and Allows optional adjudication

settings as needed.

Requires Users will not be able to approve a final result for
adjudication a workflow until an adjudication report has been
generated and a diagnosis date has been set.

Allows Users will be able to generate an adjudication
optional report at any time during the workflow, and may
adjudication optionally set a diagnosis date.

4, Click OK.
5. In the Protocol Administration window, click Close.

Frontier Science Foundation 13
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Related tasks
Generating adjudication report on page 52

Unblinding a protocol

E] Note: To access the Protocol Administration window, you must have
= system administrator privileges.

1. On the Tools menu, click Protocol Administration.
2. On the Protocols tab, click Add.

The Edit Protocol Information window will open.

Protocol: [704.0 |
Unblinded date: [[]13-Aug-2019 [~ |
[] Locked

Requires adjudication
Alows optional adjudication
[] Uses nonstandard patient 10 format

Comments:

Corc

3. In the Protocol box, enter the protocol number to be unblinded.

4, In the Unblinded date box, enter or select the date that the protocol
was un-blinded.

5. Optional: If you want to exclude any new data generated for this

protocol from SCHARP export files, select the Locked option.
6. Click OK.

After completing these steps, the unblinded study will be added to the list
on the Protocols tab in the Protocol Administration window. It can be

modified by selecting it and clicking the Edit button. It can be removed by
selecting it and clicking the Delete button.

Frontier Science Foundation 14
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Unblinding patients

E] Note: To access the Protocol Administration window, you must have
= system administrator privileges. You must also have patient information
file provided by SCHARP.

On the Tools menu, click Protocol Administration.
Select the Patients tab.
Click the Open file button.

Select the patient information file provided by SCHARP.

The list of patients to be unblinded from the file will appear in the list
on the Patients tab. This list should be reviewed for accuracy before
continuing with the unblinding.

5. Click the Unblind selected patients button.

h Wb

Configuring the test now storage location

! Note: You will need system administrator privileges to access the
Storage Administration window.

IE

A test now location is a location in the LDMS storage task associated with
an assay in HAWS. If you create a workflow for a visit in HAWS and that
visit has specimens in the test now location in LDMS, those specimens will
automatically be assigned to an assay, allowing you to bypass the select
sample task.

1. Click Tools > Storage Administration from the HAWS menu bar.

The Storage Administration window will open.

Frontier Science Foundation 15
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Figure 5: The Storage Administration window

"Test Now" locations: Q‘ I |
| s R/ VTN AB /

@ Add Edit Delete Close

(1) assay to be assigned, (2) from left to right: primary type, additive, derivative, sub additive/derivative,
(3) from left to right: LDM S freezer, level, sub-level, and container, (4) create new test now location, (5)
modify selected test now location, (6) remove selected test now location

2. Click the Add button.
The Edit Test Now Location window will open.

Figure 6: The Edit Test Now Location window

Edit Test Mow Location hod
Assay: | Multi-Spot Assay ® ~
Specimen type:

Primary: |BLD 1 |
|
Additive: |EDT

Dervative: |PL1

Sub additive denvative: |Nh’-‘-.

Test Mow location:

|
!
-
Freezer: |FREEZER =I |
| |

Rack: |TESTING
Subrack (optional): |

pox: || |
-

Cance

(1) assay to be assigned, (2) type of specimens to be assigned assay, (3) LDMS storage location

3. Select the assay to be automatically assigned to specimens in this
storage location from the Assay list.
4, In the Derivative box, specify the LDMS derivative code of specimens

to be assigned to selected assay.

Frontier Science Foundation 16
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E] Note: While the derivative is required, the specimen type
= information is not currently used by HAWS.

5. Required: Specify the exact name of the freezer to be assigned the
selected assay.
6. Specify the Rack, Sub-rack'and Box.?

e If you want a specific storage location, you can specify it by name.

e If you want to select all sub-levels (for example, all racks in a
freezer), enter * into the text box. This is used to specify all
racks, sub-racks, and boxes in the vIN AB freezer as this test now
location.

7. Click the OK button.

The new test now location will be created and added to the "Test Now"
locations list. To modify a test now location after it has been created, select
it from the "Test Now" locations list, and then click the Edit button. To
remove a test now location, select it, and then click the Delete button.

E] Note: Deleting a test now location means that specimens in the
= storage location will no longer automatically be assigned an assay. The
storage location in LDMS will not be modified or removed.

Related information
http://www.ldms.org/resources/ldms/codes/

Location administration

The Location Administration window has two purposes:

e Set the contact information for your laboratory.

e View and modify clinics that have been manually added by your laboratory
to HAWS or clinics that have been loaded from LDMS.

E] Note: For clinics that are loaded from LDMS, the LDMS clinic ID
= cannot be edited.

L A rack and sub-rack are known as levels and sub-levels in LDMS.
2 A box is known as a container in LDMS.

Frontier Science Foundation 17
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Figure 7: The Location Administration window

Location Administration X

Clinics  Lab Address o
Clinics: 9

Clinic Name LOMS ID Clinic name: |Inst'rtut0 de Pesquisa Clinica Evandro Cha|

Qac V999

Contact name: |Va|di|ea Veloso

Fundacion Hues... | V850
Inst de Pesquiza ... | V721

Address2: |Manguinhos CEP 21040-360

|
|
Address1: |A\fenida Brasil, 4365 |
|
|

Rosario Vas4

HGNI DST/AIDS | V748 City: |Rio de Janeiro

Centro de Pesqui... | V860 State: Zip code: l:l
Manaus V7El

Country: | |

Centro de Refere... |VE45
Federal Universit... | V741

Phone number: |55 21 2270 7064 |

F: ber:
Sao Paulo - Paca... | V888 &k number | |
Certro Medico 5... | V710 E-mail: |p‘tn.s'rte.121 01.HIV.Test.Results @h\dn.on;|
University of Roc... |V123
University of llino... | Y101

New clinic Save changes Delete clinic

Close

(1) clinics already added to HAWS, (2) information for selected clinic, (3) save changes to selected clinic, (4) view and
edit address of current lab

E] Note: The New Clinic and Delete Clinic options on the Location
= Administration screen are no longer used, as clinic data comes directly
from LDMS.

Your laboratory's contact information as specified in will be printed at the top
of final workflow reports generated by your laboratory.

To access Location Administration, click Tools > Location
Administration from the HAWS menu bar. A location can by modified by
selecting it from the Clinics list on the left, modifying its information on the
right side of the window, and then clicking the Save changes button. If the
location is an LDMS clinic, you will not be able to modify the LDMS clinic ID
text box for the clinic.

Holiday administration

The Holiday Administration window allows you to specify given days
during the calendar year that are considered holidays at your laboratory. This

Frontier Science Foundation 18
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ensures that days that your laboratory is not operating will be subtracted from
the calculations in the Turn Around Time reports.

E] Note: HAWS does not automatically add any holidays.

Figure 8: The Holiday Administration window

Holiday Administration >

@ Year: | 2019 || Date Holiday Description
January 2019 @

S5un Mon Tue Wed Thu Frn
1 2 3 4

& 7 2 g 1w N
13 14 15 16 17 18
20 21 2 23 24 25

27 28 29 30 AN 1

3 4 5 B a

@ Holiday Description:
Add ( 6 )

@ Save Year Close

(1) select year to add/view holidays, (2) select day for new holiday, (3) enter name for new holiday, (4) add selected
date and name as new holiday, (5) holidays already added for the selected year, (6) save changes to current year

Access the Holiday Administration window by clicking Tools > Holiday
Administration from the HAWS menu bar.

To add a holiday:

1. Select a year from the Year list.

Select a date from the calendar control.

Enter a name for the holiday into the Holiday Description text box.
Click the Add button.

Click the Save Year button

o Note: HAWS does not allow annual or recurring holidays. If a holiday
occurs every year, you will need to add it each year.

nhwnN

IE

Default algorithm setup

Setting up custom default algorithms for various Study/VID combinations can
save you a lot of time, and give you additional flexibility.

Frontier Science Foundation 19
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From the Tools menu, click Default algorithms.

Click Add.

Enter the visit unit you wish to set a default algorithm for.

Set Study to the desired study.

o o Note: Specifying a Study value allows for the ability to,
for the same visit type, use Algorithm A for one study and
Algorithm B for another study. Alternatively, you can leave

Study blank which will allow the algorithm assignment to be
applied to all studies without a specific algorithm assignment.

h Wb

Figure 9: The Default Algorithms Window
Default Algorithms

Default algorithms:

Wisit unit Study Default algorithm
Gn e oo
Eos fall} Evaluation of Sero-Reactivity E
Eox (all) Evalugtion of Sero-Reactivity Edit Default Algorithm
Fup {all) Follow-Lp Testing Service
It @) |Infected Testng Agorthm == I
Pos o) Post-Study Study (leave blark to apply to all)
Srv {all) Post-Study Testing Service Default algorithm v
VET 0000  |mAb Routine
VST 558.0 Vaccine Routine
Cancsl
Edit Delete Close

Default assay kit assignment

A default assay kit allows you to define the kit that can be used for a specific
assay on a specific algorithm

If an algorithm has a kit assignment, workflows using that algorithm will limit
the defined assay to using the selected kit. If that kit is not selected for the
assay, the specimens will not be available to add to the run.

Example default kit assignment

If you set the following kit assignment, specimens assigned the EIA 1 assay
on workflows using the routine algorithm will only be displayed if the Bio-Rad
1/2+0 kit is selected. If another kit for the assay is selected, the specimens
will not be available to add to the assay run.

Algorithm Assay Kit Study
Vaccine Routine EIA 1 Bio-Rad Genetic

Systems HIV 1/2 Plus

(0]
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Adding kit assignments

Add an assay kit default to restrict kit selection available for individual
algorithms and assays.

N =

4.

On the Tools menu, click Kit assignment.
Click Add.
Enter the following information.

e In the Algorithm box, select the algorithm to which this default
should be applied.

e In the For tests starting with box, select an assay.

¢ In the Default kit box, select the kit you want to use.

e In the Study box, select the study you want to use.

= Note: Specifying a Study value allows for the ability to,

= for the same algorithm type and test type, use test A for
one study, test B for another study. Alternatively, you can

leave the Study box blank as a wildcard option which will

allow which will allow the kit assignments to be applied to all

studies without a specific kit assignment.

Click OK.

Modify kit assignment
You can modify the kit of an existing kit assignment.

ol G

5.

On the Tools menu, click Kit assignment.

Click the kit assignment you want to change.

Click Edit.

In the Default kit box, change the kit assigned.

E] Note: Only the kit can be changed. If you need to change the

algorithm or assay, delete the kit assignment and create a new
one instead.

Click OK.

Delete kit assignment
You can remove an existing kit assignment.

ol o

On the Tools menu, click Kit assignment.
Click the kit assignment you want to delete.
Click Delete.

When you see the “Are you sure you want to permanently delete the
default kit assignment” message, click Yes.

Frontier Science Foundation
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Backup management

HAWS will automatically check if a backup of its internal database has been
created for the current date every time you start or exit HAWS. If a backup
was not created, one will be created automatically. The HAWS server installer
includes a warning text reminding the user to backup HAWS databases before
running the installer.

Backup files will be stored in the backup location on the HAWS server. One
day’s backup per file is saved and, by default, seven consecutive days are
saved in the backup directory. Each day, the oldest will be removed as a
newer one is created. Both the backup location and the number of days
backups will be retained can be changed in the Options window.

Figure 10: The Backup window

Backup HAWS Database >
Backup files: Retention days: 5
File name Date created
HAWS_Backup_2 bak 10-Jul-2019 10:11
HAWS_Backup_3bak 06-Aug-2015 15:53

HAWS_Backup_20201111.bak 11-Mow-2020 12:17
HAWS_Backup_HV_20201113.bak  13-Mov-2020 15:21
HAWS_Backup_HV_20201117bak  17-Movw-2020 11:06

Status:  Backup succeeded. Backup

E] Important: The HAWS backup location is typically on the same

= computer where HAWS is installed. This means that if something
happens to the computer, the backup files will be lost. It is important to
regularly copy automatic backups to a safe location, such as a CD-RW.

Users with system administrator privileges can manually create a backup file.
To manually create a backup file:

1. Click Tools > Backup from the HAWS menu bar.
2. Click the Backup button.

Related concepts
Options window on page 11
Steps for Verifying a Backup File

To verify a backup file, perform the following steps:

Frontier Science Foundation 22



LS.0007 | HAWS User Manual

1. Verify that the file name is as expected, in the format
"HAWS_Backup_ID_YYYYMMDD.bak (where "ID" is the two letter lab
code).

2. Verify that the file's date of creation is as expected.

3. Verify that the file size is greater or equal to that of the previous backup
file.

Tasks

HAWS works by creating tasks that represent each step for the visit in the
algorithm.

Think of tasks as steps in the workflow. The tasks within workflows are shown
on the left in the Common Tasks list. All workflows start by assigning a visit
to the workflow (the Assign a patient visit to a workflow step), after which,
they move through the remaining tasks until they are completed.

Figure 11: Basic process for a workflow in HAWS

T

Patient Visit Visit Entered Run Workflow Export HAWS Data
in LDMS in HAWS
Assign Algorithm to Visit

Select Sample to Test
Run Sample on Assay

Review & Approve Results

Generate Final Report

The basic process that a patient visit will go through, with the steps that occur in HAWS emphasized

Workflows will go through the following steps:

Assign a patient Select an algorithm for the visit, and create a new
visit to a workflow for the visit using the algorithm
workflow

Select sample Select specimens from the visit to be tested
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Process assay
Submit redraw
Receive redraw
Review assay

Result
algorithm

Final report

Add the specimens selected for testing to an assay run or
create a new assay run

Generate paperwork for submitting a request to have a
specimen for a visit redrawn

Process a specimen that has been redrawn by selecting
the specimen from the new visit

Review and approve the results from assay runs

Review all the assay results for the workflow and select a
final result for the workflow

Generate the final workflow report

There are other steps in the Common Tasks list that do not fall into the
sequential workflow for the steps listed above. Those non-sequential steps

are:

Manage runs

View all
workflows

Reassign
specimen for a
test

This step allows you to setup assay runs for different
assays. This task happens during the process assay task.
The reason it is separate from the sequential workflow

is because specimens from different workflows could be
tested on the same assay run.

This step displays all workflows that are currently in
progress, and lists their current pending tasks. From
here, you can view overall details about the workflow,
close or cancel workflows, or perform the next task for

a workflow. Think of this as a home screen so you can
gauge the overall work that still needs to be completed in
HAWS.

This step allows you to change the specimen that was
assigned to an assay after the select sample task has
been completed but before the process assay task has
been completed. You would need to do this if you wanted
to use a specimen other than the one automatically
selected by HAWS or if a manually selected specimen
was selected in error.

Assigning patient visits to an algorithm

New workflows are created by assigning an algorithm to a patient visit. This is
done using the assign a patient visit to workflow task.

1. Select the Assign a patient visit to a workflow link from the
Common Tasks list on the left.
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The Assign a patient visit to workflow window will appear.

Figure 12: The assign a patient visit to workflow task

File View Reports Tools Help

Common Tasks Group: | VTN - HIV Vaccine Trials v
Assiqn s petient visi to @ workflow Optional search filters:  (clear al fiters)
Altaslks PaiertiD: [ | Specmendatestat Import date start: (] 28-Dec-2023
Select sample task list =
P Sudy: [9960 | Specimendateend Import date end: |[]28
R Vistuit: [ | Recsveddstestat [ Include already assigned visits
Receive redraw task lit Received date end
Review assay task st Search
Resul aloorthm task s Select one or more patiert visis: {Highlight indicates already assigned visit or visit with multiple specimen dates.)
Final report tack lst Fatert Sudy Vst Soeemen Received | Inpot Ciric Agothmtostar
View ol workdlows. 267000025 9960 |6Vst | 12Mar201510:00 | 12Mar2019 V287 Instito de Fe... |mAb Routine v
287000026 996.0 6.1 Rdw |13-Mar-201910:00 | 13-Mar-2019 V287 Instituto de Pe
Reassign specimen for a test 287000044 996.0 7Ep 23-Apr-2015 11:00 | 23-Apr-2019 V287 Instituto de Pe... |mAb Recent Exp. ~
287000059 9960 (8B | 30pr201512:00 | 30-May2019 V287 Instiuto de Pe... |mAb Recert Exp... |+
287000059 996.0 9 Vst 04-May-2019 13:00 | 04-May-2019 e V287 Instituto de Pe... |mAb Routine ~
287000059 996.0 9.1 Rdw | 28-May-2019 11:00 | 28-May-2019 V287 Instituto de Pe... ~
257000059 (9960 260 | 08Jul2019 1400 | 032019 V287 Instiuto de Pe... |Corfimation Test... |+
287000015 | 996.0 10 Vst 11-Nov-2021 14:50 11-Now-2021 V287 Instituto de Pe... 'mAb Routine ~
287000015 | 996.0 10 vst 12-Nov-202110:45 12-Nov-2021 V287 Instituto de Pe... 'mAb Routine ~
v
Start warkfiow e [select ol visits) (deselect oll visis)  Vistsfound: 13 Vists selected: 1

(1) filtersfor visit search results, (2) search for visits meeting search criteria, (3) visits that meet search
criteria, (4) algorithm to use for newly created workflows, (5) create new workflow for selected visits

Select a group from the Group list.

Optional: Filter the search results by entering information into any of
the boxes in the Optional search filters section.

Optional: Select the Include already assigned visits option if you
want visits that have already been assigned to a workflow to appear in
the search results.

This may be necessary if you need to assign an additional workflow to
a visit. This might happen, for example, if a workflow for an incorrect
algorithm was created for a visit.

Click the Search button.

HAWS will display a list of available patient visits found in LDMS, or
patient visits that were manually created for the selected group. Rows
that are highlighted indicate visits that have already been assigned to
an algorithm or a visit with multiple specimen dates.

Select one or more visits.

To select more than one visit, hold down the Ctrl or Shift keys while
selecting visits. To select all visits, click the Select all visits link
below the search results.

Optional: Select an algorithm from the Algorithm to start list.
The default algorithm assigned by HAWS is determined by the visit
units and the protocols set up in the Default Algorithms screen. If the

visit unit is not one of the units listed, HAWS will not select a default
algorithm.

Click the Start workflow button to set the algorithm assignments.
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You cannot click the Start workflow button if any patient visits do
not have an algorithm selected. This would only occur if a visit's visit
unit was not recognized.

Related tasks
Receive redraw task on page 40

Select sample task

Automatic sample selection

When a select sample task is assigned to a workflow, HAWS will try to
automatically select the appropriate specimen.

Using the information entered in the Storage Configuration module, HAWS
will look up the Test Now location appropriate to the assay type. If there is
one or more specimens available in the appropriate Test Now location(s) for
the patient visit, those specimens will be selected. If there is more than one
specimen available in the Test Now location, HAWS will use the specimen
stored at the highest numbered freezer, rack, box, etc.

If there are no specimens available in the Test Now location(s), and there is
only one specimen available in LDMS (in any storage location) for the patient
visit, HAWS will select that specimen.

If more than one specimen is available you must manually select the correct
specimen. Until a specimen is selected, the select sample task will remain
pending. Additionally, it is possible to filter what samples are shown when
selecting for a particular visit to show specimens marked as never store or to
only include specimens from the same visit collection date.

Manually selecting samples

If HAWS is not able to automatically select the correct specimen for a
workflow, you will need to select the specimen manually.

1. Click the select sample task from the Common Tasks list on the left.
The Available Tasks window will appear.

2. Select the task to which you want to manually add specimens.

3. Click the Do task button.
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Figure 13: The Select Specimen window

Select Specimen

Patient information
Patiert 1D Group: VTN | Study: [9960 | vist: [Tvst | Visitdate: [18-Dec-2023

Specimens

Global specimen 1D Other specimen 1D Draw date Received date Import date  Storage location Primary Additive Derivative  Sub addtive/derivative
0461-08COVFOD-001 18-Dec-2023  18-Dec-2023 VAZIO /1 /1/BOX 1-BLD -052 / 004,003 BLD EDT PLZ N/A
0461-D3COVF00-002 18-Dec-2023  18-Dec-2023 VAZIO /1/1/BOX1-BLD 052 /004004 BLD  EDT PL2 N/A
0461-08C0OVFOD-003 18-Dec-2023  18-Dec-2023 VAZIO /1 /1/BOX 1-BLD -052 / 004,005 BLD EDT PLZ N/A
0461-D3COVF00-004 18-Dec-2023  18-Dec-2023 VAZIO /1/1/BOX1-BLD 052 /004006 BLD  EDT PL2 N/A

[ Include specimens marked as unavalable [ Include only specimens from the visit's draw date Cancel

The Select Specimen window will appear. This is where you select
a specimen. The specimens for the selected patient and visit that are
currently available in LDMS will be displayed.

4. Select a specimen from the list.

Related tasks
Reassigning a specimen on page 27
Receive redraw task on page 40

Reassigning a specimen

The workflow must be in the process assay task, and no results yet entered
for the specimen that is currently assigned.

You can reassign a specimen that already has a result to a task. If you do
this, the specimen's existing result will be used.

After completing the select sample task, it may be necessary to change the
specimen was selected for a test. This may happen if you want to use a
specimen other than one automatically selected by HAWS or if a specimen
was selected in error.

In the Common Tasks list, click Reassign specimen for a test.
In the Pending Tests list, select the test to modify.
Click Change specimen.

. Select a new specimen to be tested. Specimens for the visit entered
into LDMS will be displayed in the Specimens list.

Click the OK button.

AWNKR

u
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The specimen assigned to the assay will be changed to the one you specified.
The workflow will remain in the process assay task until that task is
completed.

Related tasks
Manually selecting samples on page 26

Assay run management

The manage runs task is used to view runs that have been set up for each
assay supported by HAWS. By default, only runs that have not yet been
completed are displayed. Previously completed runs can be displayed by
selecting the Show completed runs option.

Figure 14: The manage runs task

Assay: | (Any) ® ¥
Ki: | (any) @ -

Awailable runs: [ Show completed uns

Date created Status Print specimen Iocator
D‘I lun-2017 Readyfor Review Print run worksheet
Abbott Architect HIV Ag/Ab Combo 05-Jun-2017 Ready for Review Print completed run worksheet \c\orksheet

Abbott Architect HIV Ag/Ab Combao

O

et
Edit run Enter/review results

06-Jun-2017 Imported

(1) selected assay, (2) selected kit for assay, (3) runs for the selected assay and kit, (4) change the specimens to
be tested on the selected run, (5) run the assay or approve results, (6) create new run for selected assay and kit, (7)
generate paperwork for selected run

The paperwork that can be printed for the assay run will vary, depending on
the type of assay and its current status. The Print specimen locator option
will be available for all assay runs.

Creating a new run

1. Select the manage runs task from the Common Tasks list on the left.
2. Select an assay from the Assay list.
3. Select an assay kit from the Kit list.
The kit options available will vary, depending on the assay selected.
4, Click the New run... button.
The Setup Assay Run window will open.
5. Select the specimen(s) to be tested from the Available samples list.
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The available samples are all specimens assigned to this assay across
all active workflows, except for algorithm-assay combinations with a
different defined assay kit. To select multiple specimens, press and
hold the Ctrl or Shift key.

6. Click the U button.
The selected specimen(s) will be moved to the Selected samples list
at the bottom of the window.

7. Click the Save run button.

The new assay run will be created and assigned a run ID. It will have the
initial status of pending.

Related reference

Supported assays on page 7
The following assays and kits are supported by HAWS.

Assay run reports

There are several useful reports that can be generated from the run
management task. These reports are available to the right of the Available
runs list.

Specimen This report can be used to help locate specimens to

locator report be retrieved for testing. The report includes specimen
identifiers such as the global specimen ID or other
specimen ID. If the specimen was added to storage in
LDMS, the report will also include the LDMS storage
location.

Run worksheet This report can be generated for the Enzyme Immuno

report Assay (EIA), Multi-Spot Assay, OraQuick Assay, and
theAlere Assay. This report can be used to assist in
manually recording and entering the results of an assay
run. It lists each test on the run, with blank spaces
provided for you to enter the results.

Completed This report can only be generated for runs that have
run worksheet already been entered. It can be used to assist in the
report verification and approval of results for each test on the

run. It is similar to the Run Worksheet Report, except
that it includes the test results that were entered.

Running an assay
1. Open the manage runs task.

2. Select an assay from the Assays list.
To display all pending assay, runs, select (any) from the Assay list.
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3.

Select a kit from the Kit list.

To display runs for all kits for the selected assay, select (any) from
the Kit list.

Select an assay run from the Available runs list.

If you do not see an assay run, you may need to create it.

Click the Enter/review results button.

The Assay Results window for the assay appears. This window
contains information about the run and specimens being tested. The
Samples list contains a listing of specimens being tested on the run.
These specimens are in the same order as they would appear on the
Specimen Locator Report, Run Worksheet Report, and Completed Run
Worksheet Report.

Figure 15: The Assay Results window

Assay Results *
Run ID: Patient ID:
Kit: |Bio-Rad Geenius HIV 1/2 Confimatory As Visit:
[ Assigned to technician for testing Draw date: @
Tested by: | F. Sales (FS) > Global specimen 1D:
Test date: | 01-Jun 2017 [E | Cther specimen 1D: l:l
Samples: Comments:
Specimen
HDKOF536-02
[] Donctrepot  [] Do not export to SCHARP
@ Final resutt: | HIV Negative m
Ertered by: [F. Sales (FS) S
Entered dte: (?)
Approved by: 1. Georg (IG) |
Approved date: De-approve results‘ 5 '
gpd6: |- CTRL: |+
gpl4l; - HIV-linterp: | Negative
p3l: B HIV-2interp: | Negative
ap160:
p24:
@ gp4l:
Close

(1) specimens being tested, (2) details for selected specimen, (3) final result for the assay run, (4) finalize
results for selected specimen, (5) approve committed results, (6) fields specific to the assay being run will
appear here, (7) save changes and close the window

The Samples list shows the following information:

E] Note: If you only see the specimen identifier for specimens
= being tested, click View > Extra test info in assay results
from the HAWS menu bar.
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10.

11.

specimen This is the identifier for the specimen, such as the
global specimen ID

Patient ID This is the patient identifier for the specimen

Wf ID This is the workflow ID for the workflow to which

the specimen is assigned.

T Indicates whether or not the specimen has been
tested. Y indicates that the specimen has been
tested; N indicates that the specimen has not been
tested.

R Indicates whether or not the specimen has had
its result committed in HAWS. Y indicates that the
specimen result has been committed; N indicates
that the specimen has not yet been tested.

A Indicates whether or not the specimen's result has
been reviewed and approved. Y indicates that the
result has been approved; N indicates that the
specimen has not yet been approved.

Optional: To change the status of the run to Assigned, select the
Assigned to technician for testing option.

If you select this option, you can click the Close button to exit the
Assay Results window. The status of the assay run will be updated to
reflect that it has been assigned.

Select a specimen from the Samples list on the left.

Optional: If you do not want to include this test's results in the final
report for the workflow, select the Do not report option.

Optional: If you do not want to include this assay test's results in the
export file that is generated to be sent to SCHARP, select the Do not
export to SCHARP option.

Enter the assay results in the fields on the right.

The result fields will vary, depending on the assay you are running.
Refer to the appropriate section for the assay you are running for
more information.

After the results for each specimen have been entered, click the
Commit results button.

Committing results indicates that you are finished entering results for
the assay.

= Important: Committing results immediately advances the
= workflow to the review assay task if all tests for the current step
in the workflow are completed.

Note: If you attempt to modify results after they have been
committed, you will be prompted with a warning, but will still be
permitted to change the result. Runs that have been approved
cannot be modified unless they are de-approved.
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12. Click the Close button.

Changes made to the assay run will automatically be saved. If you
want to close the window without saving changes, select the X button
in the upper-right corner of the window.

At this point, the assay has been run, however the results have not been
approved.
Related tasks

Export reports on page 52
Export reports are tab-delimited text files that are intended to be sent to
SCHARP.

Available Results for Assay Types

Abbott Prism assay
The valid options for the specimen Final result are:

e Reactive

e Nonreactive

e Equivocal

¢ QNS

e Invalid

e Test Not Performed

Bio-Rad Geenius HIV 1/2 Confirmatory Assay
The valid options for the specimen Final result are:

e HIV Negative

e HIV-2 Indeterminate

e HIV-1 Indeterminate

e HIV Indeterminate

e HIV-1 Positive

e HIV-2 Positive

e HIV-2 Positive (with HIV-1 Cross-reactivity)
e HIV Positive Untypable
¢ QNS

e Invalid

e Test Not Performed

e Inconclusive

Results can be entered for the following bands, with plus or minus available
for each band:

e gp36
e gpl40
e p31
e gpl6eo
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e p24

* gpal

o Ctrl

Results can be entered for HIV-1 Interpretation and HIV-2 Interpretation, and
the result options for those are the following:

e Reactive

e Non-reactive

= Note: The field for the result option can be left blank.

HAWS will only permit a test result to be committed or approved if none

of the bands are unspecified, unless the result is invalid, QNS, or test not
performed. HAWS will also calculate the expected result, and warn you if the
result selected does not match the expected result.

Alere assay

There are three result fields that must be completed for this assay:
e control

e HIV-1 p24 Ag

e HIV-1/2 Ab

For each band, select either reactive or non-reactive. These boxes must be
completed, unless the final result is QNS, Invalid, or Test Not Performed.

The valid options for the final test result are:

e Non-reactive

e Reactive for HIV Antibody

e Reactive for HIV Antigen

e Reactive for HIV Antibody and Antigen
e QNS

e Invalid

e Test Not Performed

DNA PCR assay

The valid options for the final test result are:

e Detected

e Not Detected

e Equivocal

e QNS

e Invalid

e Test Not Performed

Enzyme Immuno Assay (EIA)

The following result fields are specific to the EIA assay:
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Final result HAWS will automatically complete this field for you
based on the OD/cutoff ratio. You can override the
automatically calculated result if needed. The following
options are available for the EIA final result:

e Reactive

e Non-reactive

e Equivocal (only available for the Bio-Rad GenScreen
HIV 1/2 and Bio-Rad Genscreen Ultra HIV Ag-Ab HIV
1/2 kits)

e QNS

e Invalid

e Test Not Performed

Qualifier This is the operand for the OD. By default, this field is set
to =. If the reader device detected an OD outside of its
range of quantitation, you would need to change this to
reflect the range.

oD The OD result for the specimen. The default value is
blank. You must enter a non-negative humber unless
the Final Result field is Invalid, QNS, or Test Not
Performed.

Cutoff The cutoff result for the specimen. The default value is
blank. You must enter a non-negative humber unless
the Final Result field is Invalid, QNS, or Test Not
Performed.

OD/cutoff ratio This read-only value is automatically calculated based on
the OD and Cutoff that you entered for the specimen.

s/Cco This field is displayed instead of OD and cutoff for the
Abbott Architect HIV Ag/Ab Combo and Abbott Axsym
HIV Ag/Ab Combo kits. The default value is blank. You
must enter a non-negative humber unless the Final
Result field is Invalid, ONS, or Test Not Performed.

HAWS will complete the Final result field for you using the logic described
below. You can override the result chosen by HAWS and select a different
result. If the ID/cutoff ratio is modified, HAWS may modify the Final result,
but will provide you with a message if it does.

For all EIA kits other than the Bio-Rad GenScreen HIV 1/2 and Bio-Rad
Genscreen Ultra HIV Ag-Ab HIV 1/2 kits, HAWS will suggest a final result
using the following logic:

e Ratio greater than or equal to 1.0 will be considered rReactive
e Ratio less than 1.0 will be considered Non-reactive

For the Bio-Rad GenScreen HIV 1/2 and Bio-Rad Genscreen Ultra HIV Ag-Ab
HIV 1/2 kits, the following logic applies:

e Ratio greater than or equal to 1.0 will be considered rReactive
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e Ratio between 0.90 and 0.99, inclusive, will be considered Equivocal
e Ratio less than 0.90 will be considered Non-reactive

HIV-1 Total Nucleic Acid Assay
The valid options for the specimen Final result are:

e HIV-1 Nucleic Acid Detected

e HIV-1 Nucleic Acid Not Detected
e Inconclusive

e Indeterminate

e Invalid

e QNS

e Test Not Performed

Multi-Spot assay

The following result fields must be completed for each Multi-Spot assay
specimen:

Control

HIV-1 Peptide
HIV-1 Recombinant
HIV-2 Peptide

The valid options for each of these fields are Reactive or Non-reactive (Or
null if the Final result for the specimen is Invalid, QNS, Or Test Not
Performed).

The valid options for the Final result are:

e Non-reactive

e Reactive, HIV-1

e Reactive, HIV-2

e Reactive, HIV-1/2
e Invalid

e QNS

e Test Not Performed

Open discretionary assay

The open discretionary assay is not part of any workflows. It can only be
assigned as a discretionary assay. It is intended for scenarios when the
laboratory needs to provide results for a discretionary assay not already
defined in HAWS.

You must provide the following information about the assay.
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Field Options

Final Result HIV-1 Antibody Reactive/Positive

HIV-1 Antibody Non-reactive/Negative
HIV-2 Antibody Reactive/Positive

HIV-2 Antibody Non-reactive/Negative
HIV Antibody Reactive/Positive

HIV Antibody Non-reactive/Negative
HIV-1 Antigen Reactive/Detected

HIV-1 Antigen Non-reactive/Not Detected

HIV Antibody and Antigen Reactive/
Detected

HIV Antibody and Antigen Non-reactive/Not
Detected

Reactive/Positive/Detected
Non-reactive/Negative/Not Detected
HIV-1 Nucleic Acid Detected
HIV-1 Nucleic Acid Not Detected
HIV-2 Nucleic Acid Detected
HIV-2 Nucleic Acid Not Detected
Equivocal

QNS

Invalid

Inhibited

Inconclusive

Indeterminate

Non-specific
Test Not Performed
Other
Assay Name Enter the name of the assay
Analyte HIV-1 Antibody

HIV-2 Antibody

HIV-1 and HIV-2 Antibody
HIV-1 Antigen

HIV Antibody and Antigen
HIV-1 RNA

HIV-1 DNA

HIV-1 RNA and DNA (TNA)
HIV-2 RNA

HIV-2 DNA

HIV-2 RNA and DNA (TNA)
Other

Related tasks
Adding a discretionary test to a workflow on page 44

RNA PCR assay

There are two result fields that must be completed for this assay:

qualifier This is the operand for the Copies/mL. By default, this
field is set to =. If the reader device detected copies
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outside of its range of quantification, you would need to
change this to reflect the range.

copies/mL Must be a non-negative integer. Can only be left
blank if the Final result for the specimen is Invalid,
Inhibited, QNS, Or Test Not Performed.

The valid options for the final test result are:

e HIV-1 RNA Detected

¢ Not Detected

e QNS

e Invalid

e Inhibited

e Detected Below Limit of Quantitation
e Detected Above Limit of Quantitation
e Test Not Performed

Western Blot assays

The Western Blot assays have result fields for each blot band. All blot bland
fields will be blank by default. You must select a result for each blot band
unless the Final result is Invalid, ONS, or Test Not Performed.

The following are valid options for the Final result field for Western Blot
assays:

e Positive

e Negative

e Indeterminate

e QNS

e Invalid

¢ Non-Specific

e Test Not Performed

Approving assay runs

E] Note: To approve results, you must have the user can approve results
= permission for your account.

After assay results have been committed by a user entering or importing
them, they must be verified.

1. Open the Manage runs task.
2. Select the assay run that you want to approve.
3. Click the Enter/review results button.
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The Assay Results window will open.

4. Select a specimen from the Samples list on the left.
The results for the selected sample will be displayed on the right.
These are the results you are reviewing.

5. Click the Approve results button.
The specimen results will be approved and the Approve results
button will change to De-approve resulits.

6. Repeat for each specimen in the Samples list.

7. After all specimens have been approved, click the Close button.

The assay run is now considered reviewed and approved. If the run had a
final result of 1nvalid, the results will not be used by HAWS but the results
will be included in the export file (unless the option to exclude the results
from the export file was enabled).

Once the result has been approved it cannot be modified. If an approved
result needs to be modified, you must first De-approve the result

Associating assay results from another workflow

For assays common to multiple algorithms, HAWS allows you to transfer the
results for the same time point from the assay on one workflow to another
workflow.

To use the results of a previously run assay, click the Use Selected Test
button. If manually completing the Process Assay task is needed, click the
Don't use an existing test button.

Importing assay results from a file

You can import results from an assay reader device for some assay Kkits.
Results can be imported from the following kits:

e Bio-Rad Genetic Systems HIV 1/2 Plus O

e Bio-Rad GS HIV Combo Ag/Ab EIA

e Bio-Rad Genetic Systems rLav

e Bio-Rad Geenius HIV %2 Confirmation Assay
e Abbott Architect HIV Ag/Ab Combo

Importing assay results from a file allows you to bypass entering the results
manually.

1. Open the manage runs task.
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N

Select the appropriate run from the Available runs list.

Click the Import results from file button.
A dialog window will open for you to browse to the file to be imported.

Select the file that you want to import.

HAWS will extract all results from the file, and any existing results will be
overwritten.

HAWS will extract the appropriate test data for each sample on the run.

Submit redraw task

Certain combinations of results may cause a redraw task to be assigned for a
workflow. The exact circumstances will vary, depending on the algorithm.

To initiate a redraw request for a specimen:

ol o

Select the submit redraw task from the Common Tasks list.

Select the workflow for which you want to process a redraw request.
Click the Do task button.

Optional: Change the default text in the Summary box.

4.1. Click the Select text... button.

4.2, Select a new template from the Redraw reason list.

4.3. Click the OK button.

4.4. Update the text in the Summary box.

Click the Print redraw report button.
The Blinded HIV-1 Infection Status Report will open in the SAP Crystal
Reports® Report Viewer.

Required: Click the [Print] icon from the Report Viewer toolbar.
E] Important: You must print the Blinded HIV-1 Infection Status

Report. The workflow will not move on to the receive redraw
task until the report has been printed.

After the Blinded HIV-1 Infection Status Report has been printed, the
workflow will be moved to the receive redraw task.

Related tasks
Adding a discretionary redraw to a workflow on page 45
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Receive redraw task

The receive redraw task is for workflows that have completed the submit
redraw task. After the redraw has occurred, you need to associate the new
visit as a redraw visit for the patient. To do this:

1. Open the receive redraw task from the Common Tasks list on the
left.

2. Select the workflow for which you have a redrawn specimen.

3. Click the Do task button.

The Select Redraw Visit window will open. This window is similar to

the assign a patient visit to a workflow task. Only visits for the patient
with specimens that have a specimen date on or after the date of the

original specimen being redrawn will be displayed.

4, Select the visit with the redrawn specimen.

e If the visit was entered in LDMS, it will be listed in the Select
Redraw Visit window.

e If the visit was not entered in LDMS, click the New visit button to
create it.

5. Click the OK button.

The workflow will be moved to the select sample task, and you can now test
specimens from the redraw visit. You can continue to process the workflow as
normal.

E] Note: the workflow will only create a select sample task if the
algorithm triggers tests after a redraw and will not be the case after
a discretionary redraw. If this is the case, the user must create
discretionary tests on their own.

Related tasks
Manually selecting samples on page 26
Assigning patient visits to an algorithm on page 24

Result algorithm task

o Note: To complete the result algorithm task, you must have the user
= can approve results permission.
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The result algorithm task is used to review and assign a final result to a
workflow. After all specimen testing work has been completed for a workflow,
the workflow will be assigned to the result algorithm task. This is where you
will review the results for specimens tested and select the final result for the
workflow.

1. Open the result algorithm task.
2. Select the workflow for which you want to complete the result
algorithm task .

E] Note: If you do not see the workflow available, go to the view
all workflows task and ensure that all other necessary tasks
have been completed.

3. Click the Do task button.
The Algorithm Summary window () will open.

Figure 16: The Algorithm Summary window

Algorithm Summary
Fatient ID: | SENSRSRSSS: Worldlow ID: 97 Sudy: 5380 [] Donot export ] Do not report
Resutts | Tasks | Discretionary actions
Test Run M
T Kit name Visit Result Test date D Detail

EIAT Abbott Architect HIV Ag/Ab Combo 28 Aug 2019 16:01 S/CO[5.00]

RNAPCR Abbott m2000 RealTime PCR HI_. | 1Vat HIV-1 RNA 28-Aug-2019 16:01 di I Copies/mL[6789]

EIAT Abbott Architect HIV Ag/Ab Combo | 1RDW | Nonveactive | 28-Aug-2019 16.03 5/C0[0.10]
RNAPCR  |Abbott m2000 RealTme PCRHL.. | 1RDW Mot Detected | 28-Aug-2019 16:03 | 5= Copies/mL{<40]
Geenius Bio-Rad Geenius HIV 1/2 Confir... |1RDW | HIV-1Positive | 28-Aug-2019 16:04 |51 gp36l+] gp140[] p31l+] gp160[+] p24[+] gpa1l+] CTRLI] HIV-1Intemp[Reactive] HIV-2 Interp[Non-=a...
o/
Proposed resut: |(None proposed) Reviewtest resut
Final resut v Approve result
Blinded resuit Unbiinded resut Select text

Diagnosis date 16-Sep-2013 @

Approved by The final result cannot be approved at this time, because i is not yet set
Date approved:

General comments Intemal only commerts
Blinded report commerts: Unblinded report comments

Close.

(1) view tasks that were completed for the workflow, (2) view and create discretionary tests and redraw
tasks, (3) final result for the workflow, (4) approve workflow final result, (5) review the results for the
selected test, (6) date infection was diagnosed for positive results only, (7) summary comments as will
appear on unblinded reports, (8) tested completed for the workflow, (9) general comments that appear on
HIV status report, (10) internal-only comments that are not exported or shown on reports, (11) blinded
report comments that show only on the blinded report, (12) unblinded report comments that only show on
the unblinded report

4. Review all of the test results.
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10.

4.1. Select a test on the Results tab.

4.2. Click the Review test result button.

4.3. Click the Close button when you are finished reviewing.
Select a final result for the workflow from the Final result list.
The Proposed result field provides a suggested Final result that
was determined by HAWS.

If the Final result is Infected, specify a Diagnosis date

This is only required if there are infected specimens from multiple
dates. If the infected specimen is from one date, HAWS will
automatically select it for you. For protocols that require adjudication,
you will not be able to complete the Diagnosis date until the
Adjudication Report is generated. This is done by clicking the Report
to Adjudicator button that will appear next to the Diagnosis date.
For algorithms that have an unblinded result, select the Unblinded
result [summary text].

The following algorithms have an unblinded result:

e Evaluation of Sero-Reactivity

e Evaluation of Sero-Reactivity Recent Exposure
e Post-Study

e Post-Study Testing Service

e Confirmation Testing Service

e Follow-Up Testing Service

HAWS will automatically select text for you. You can select a different
summary text template by clicking the Select text... button.

Enter comments into the following Comment text boxes:

e General comments: the text you enter here will appear on the HIV
status final report

e Internal-only comments: the text you enter here will not be
exported or appear on reports

e Blinded report comments: The text you enter here will show only
on the blinded report

e Unblinded report comments: the text you enter here will show only
on the unblinded report

E] Note: If you change the Final result for a workflow for which
= a final workflow report has already been printed, you must
enter a comment to explain why the result was changed.

Click the Approve result button.
Click the Close button.

The completed workflow will be assigned the final report task.
Related tasks
Cancelling an algorithm for a workflow on page 47

Frontier Science Foundation

42



LS.0007 | HAWS User Manual

Final report task

After a workflow has completed the result algorithm task, it will be assigned
the final report task. For this task, you will generate the final workflow report.

E] Tip: You can print the final reports for several workflows at once from
= the Reports menu.

[y

Open the final report task.
Select the workflow for which you will be generating a report.

3. Click the Do task button.
The SAP Crystal Reports® Report Viewer window will open with the
HIV Infection Status Report.

4, Click the Print button from the Report Viewer toolbar.

N

E] Note: The final report task for the workflow will not be
= completed until the report is printed.

Related tasks
Batch printing final reports on page 50

Workflow management

View all workflows

The view all workflows task allows you to see all active (and inactive)
workflow on one screen, as well as each workflow's currently assigned task.
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Figure 17: The view all workflows task

Filter by: Patient ID: @ [ Include completed and teminated workdlows Refresh
Pending task: ~ 2

Workflows

Patient

. -
D ‘.gnrkﬂnw Workflow name Study Visit g;ec'men Completed at Pending task

e ate
267400418 |83 |Routine AMP 01un-2017 C |oedna0r [ —

Algorthm start
d

@G (6 @) .

Details.. Add discretionary test.... Add discretionary redraw... Do task

(2) filter workflows that are displayed, (2) next task to be completed for the workflow, (3) workflows meeting filter
criteria, (4) view or approve selected workflow, (5) generate (or re-generate) final workflow report, (6) add a new
discretionary test to the selected workflow, (7) add a new discretionary redraw to the selected workflow, (8) complete
the next task for the selected workflow

Almost all of your work in HAWS can be completed from this screen. It is also
very useful for keeping track of open workflows. From this screen you can do
the following:

e Execute the next task in a workflow

e Review previous tasks, assay run results, and the HIV Infection Status
Report

e Add discretionary tests and discretionary redraws
e Modify the export status of a workflow.

Discretionary tests and redraws

Adding a discretionary test to a workflow

In addition to the tests automatically generated by HAWS, you can add

discretionary tests to any active workflow.3Discretionary tests are processed
just like tests assigned by an algorithm. The workflow will be assigned the
select sample task and process assay task to complete the discretionary test.

The results from discretionary tests will appear in the Algorithm Summary
window with other test results and will appear on the workflow's final report.
Discretionary tests will also be exported to SCHARP (unless explicitly excluded

3 You cannot add discretionary tests to workflows using the Infected or
Retrospective algorithms.
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by the user). Discretionary tests will not be used, however, in the automated
determination of a proposed final algorithm result.

1. Open the view all workflows task.
2. Select the workflow for which you want to add a discretionary test.
3. Click the Add discretionary test... button.
The Start Discretionary Test window will open.
4, Select an assay from the Available assay types list.
5. Optional: Modify the Assay name box.
6. Click the OK button.

The discretionary test will now be added to the workflow and can be
completed like any other assay in a workflow. You can see what discretionary
tests have been assigned to a workflow on the Algorithm Summary window,
accessed by selecting the workflow in the view all workflows task, and then
clicking the Details button.

Related concepts

Open discretionary assay on page 35

Adding a discretionary redraw to a workflow

A discretionary redraw allows you to manually add a submit redraw task to a
workflow. This can be done for the following algorithms:

e Routine (VST) (and Routine Vaccine or mAb)

e Evaluation of Sero-Reactivity (EOS)

e Evaluation of Sero-Reactivity Recent Exposure (EOX)
e Post-Study (POS)

e Recent Exposure/Acute Infection (EXP) (and Recent Exposure/Acute
Infection Vaccine or mAb)

After a new visit has been selected, it becomes the current visit for the
workflow, provided that it is the most recent visit. Any new discretionary tests
and select sample taskswill be associated with the redraw visit.

Redraw visits will be included on the workflow's final report.
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Fitter by: Patient 1D: [ Include completed and terminated workdlows
Workflows: Pending task: w
:’Daﬁent “ngorkﬂow Workflow name Study Visit i;e:imen Completed at Ng:rithm start Pending task

Routine AMP 01 2 Report

83 -2017 0 7

Start Discretienary Redraw

The following redraw reasons are available for the selected algorithm ("Routine AMP™).
Please select the reason to be used for the initial text of the redraw request. ({This text can
be edited when submitting the redraw request )

Redraw reason
<Mone> - Reason text wil intially be blank.

Further Testing Required. Draw new sample per protocol requirements and submit using
vistt type "Redraw/RDW".

Further Testing Required. Draw a new 10 mL EDTA whole blood sample using visit type
"Redraw/RDW". Ship the whole blood tube {unprocessed) ovemight, ambient, to the
HDTL.

[+] Automatically add EIA, RNA PCR, and Geenius tests after redraw is received

Detals.. | | Viewrepon | | Add wary test... | [ Add ary redraw... | | Dotask |
1. Open the view all workflows task.
2. Select the workflow for which you want to add a discretionary visit

from the Workflows list.
3. Click the Add discretionary redraw... button.
E] Note: If the Add discretionary redraw... button is disabled,
= the workflow may have an algorithm that does not allow
discretionary visits.
The Start Discretionary Redraw window will open.

4. Select the desired reason for requesting the redraw the from the
Redraw reason list.
The redraw reasons available will vary, depending on the workflow's
algorithm. You will be able to change the text of the redraw reason
prior to generating the redraw request report.

5. Check the box at the bottom of the window if automatically adding
EIA, RNA PCR, and Geenius tests after the redraw is received is
needed.

6. Click the OK button.

The workflow will be assigned a submit redraw task. Complete the submit
redraw task as normal.

Related tasks
Submit redraw task on page 39
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Cancelling discretionary tests and redraws

Discretionary tests and redraws can be removed from a workflow if they
should not be completed or were added in error.

1. Open the view all workflows task.

2. Select the workflow for which you want to remove a discretionary visit
or redraw.

3. Click the Details... button.
The Algorithm Summary window appears.

4. Change to the Discretionary actions tab.
This tab shows all discretionary tests and discretionary redraws that
have been added to a workflow.

5. Select the discretionary test or redraw to be removed.

6. Click the Delete button.

Cancelling an algorithm for a workflow

Cancelling an algorithm for a workflow means that you want to depart from
the normal steps in the workflow's algorithm. You will still be able to perform
discretionary tests and redraws. You will also still be able to set the final
result for the workflow and complete the final report task.

Cancelling an algorithm differs from closing a workflow. Cancelling an
algorithm interrupts the algorithm for the workflow, but still allows you to
generate a final report for the workflow. Closing a workflow ends the workflow
without the option to generate a final report.

[y

Open the view all workflows task.

Select the workflow you want to cancel from the Workflows list.
3. Click the Details button.

The Algorithm Summary window will appear.

4, Click the Cancel automated algorithm button.
You will be asked to confirm that you want to end the algorithm for
the selected workflow.

N

Any discretionary tests or redraws assigned to the workflow must still be
completed. Once there are no pending discretionary tasks, the cancelled
workflow will be assigned the result algorithm workflow task.
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Related tasks
Result algorithm task on page 40

Closing a workflow

You can close any workflow that has not completed the result algorithm task.
You may need to close a workflow because it was created in error or because
it was created using the wrong algorithm. Closing a workflow will cancel any
pending tasks for the algorithm (discretionary tasks will remain). You will not
be permitted to set a final result or print a final workflow report.

Warning: Closing a workflow will automatically apply the Do Not
Export and Do Not Report options to the workflow.

1. Open the view all workflows task.

2. Select the workflow that you want to close from the Workflows list.
The Algorithm Summary window will open.

3. Click the Close algorithm button.

Available reports

HAWS has several reports that are useful for managing your laboratory's
workflows and productivity.

To generate these reports, click Reports > [Report name] from the HAWS
menu bar. For some reports, you may be asked to supply some information
prior to generating the report, such as a date range.

The following reports are available:

Crashed The Crashed Workflows report lists which workflows

Workflows have crashed. The user may use this to verify if a new
workflow was initiated as a replacement.

Pending The Pending algorithms report shows all workflow tasks

algorithms that are in progress and not yet completed. Tasks are

grouped by workflow.

Pending redraw The pending redraw samples report lists all pending

samples receive redraw tasks (that is, specimens for which a
submit redraw task has been completed and the report
printed).
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Protocol/visit
type summary

Tests per
algorithm

Turn around
time >= X days

Turn around
time details

Turn around
time non-
exported

Turn around
time summary

Turn around
time with
redraws only

Visits per
algorithm

The Protocol/visit type summary report lists the
workflows that have been started or completed for each
patient.

The Tests per algorithm report lists the number of runs
for assay kits. The report is grouped by both kit and by
algorithm, and distinguishes between initial visits and
redraws.

The Turn around time >= X days report shows workflows
with a turn around time of greater than or equal to X
days, where X is a number of days specified by the user.

View turn around time details.

The Turn around time non-exported report shows
workflows that have not yet been exported.

The Turn around time summary report shows the turn
around time difference in days from each event to

the next event for each workflow. Weekend days are
excluded from the calculation as well as any holidays
that were entered within Holiday Administration. The
Turn Around Time Summary Report is broken down into
percentile ranks. Each rank ignores a certain percentage
of the events for that workflow to show the average and
maximum for the remainder. The following percentages
are included:

average/ Shows the averages and maximums for
maximum  all events

(100)

average/ Shows the averages and maximums with
maximum the bottom 5% (slowest) events of each
(95) type excluded

The Turn around time with redraws only report shows
workflows that included at least one redraw.

The Visits per algorithm report lists the number of visits
for algorithms within a date range specified by the

user. The report distinguishes between initial visits and
redraws.
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Batch printing final reports

E] Note: Only users with the Can print reports privilege can batch print
= reports.

HAWS can print the final reports for multiple workflows at once. This feature
can be used to save time by printing multiple reports at once. The reports will
be saved automatically in PDF format and printed without needing to open
SAP Crystal Reports® Report Viewer.

Warning: Using this feature will automatically print the selected
reports to your default printer. If you need to specify the printer to use,
you must change the default printer in your Windows® Control Panel.

1. Click Reports > Batch-print reports... from the HAWS menu bar.
The Print Reports window will open.

2. Optional: If you want to print reports that have already been printed,
select the Include already created reports option.

3. Select the report(s) to print.

To select multiple reports, hold down the Ctrl or Shift key.
4, Optional: Click the Print list.

This will display a list of the reports that will be printed. You can print
this list for review, if needed.

5. Click the Print reports button.

The reports will be printed from your computer's default printer. PDF files for
each report will also be generated and saved to your computer. They will be in
the Reports folders. There will be a directory in the Reports folder for each
clinic. Within each clinics folder will be the PDF report.

The default location for reports can be modified in the Options window.

Related concepts

Options window on page 11
Related tasks

Final report task on page 43
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Creating unblinded EOS/EOX reports

E] Note: Only users with the Can print reports privilege can batch print
= reports.

Prior to a protocol being unblinded, SCHARP receives unblinded EOS/EOX
reports. SCHARP will request that the laboratory send unblinded EOS/EOX
reports for all patients on a specific protocol, or they may send the laboratory
a text file containing a list of patients whose unblinded EOS/EOX reports
should be sent.

1. Click Reports > Create unblinded EOS reports for SCHARP from
the HAWS menu bar.
The Create Unblinded Reports for SCHARP window will appear.

2. Do one of the following:

e If SCHARP provided your laboratory with a protocol number, enter
the protocol into the Create reports for all algorithms for this
protocol box.

e If SCHARP provided your laboratory with a text file listing of
patients, click the Open file button and select the text file.

3. Optional: If you want to print reports that have already been printed,
select the Include already created reports option.

4, Select the reports to be printed.
To select multiple reports, hold down the Ctrl or Shift key.

5. Click the Create reports button.

PDF files for each report will be generated and saved to your computer. They
will be in the Reports folders. There will be a sub-directory in the Reports
folder called unblinding. Within this directory will be a directory for each
clinic, and within each clinic's folder a PDF of the report.

Figure 18: Unblinding report directory structure

C:\fstrf-haws\Reports\Unblinding\ [protocol]\[clinic]\ [report] .pdf
Figure 19: Report PDF file naming convention

[PatientID]-v[Visit Number]-[Draw Date]-
rpt [Algorithm]Unblinded.pdf
123456789-v7-24Aug-2009-rptEvaluationofSeroReactivityUnblinded.pdf

The default location for reports can be modified in the Options window.
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Related concepts
Options window on page 11

Export reports

Export reports are tab-delimited text files that are intended to be sent to
SCHARP.

An export file is generated for each protocol and contains test results for all
completed workflows. Results for sub-studies are included in the same export
file as the parent protocol.

Only test results from completed workflows are included in export files.
Results from protocols marked as locked will not be exported, nor will
individual tests or workflows that have been marked as Do not export.

E] Note: Western Blot tests using the Bio-Rad New Lav Blot II kit will not
= be included in export files.

1. On the File menu, click Export Results.
2. When the “Export Results” message appears, click OK.

The export files will be placed in the export base folder.
E] Note: If any export files were generated again, their filename will be
= appended with a number.

Related concepts

Options window on page 11
Related tasks

Running an assay on page 29

Generating adjudication report

1. In the tasks list, click View all workflows.

2. In the Workflows list, select the workflow for which you will be
generating the adjudication report.

3. Click Details.

4, (If required), select the result from the Final Result box.

5. In the Diagnosis box, select the date of the diagnosis.

Frontier Science Foundation 52



LS.0007 | HAWS User Manual

6. Click Report to adjudicator.

The adjudication report will be in the Adjudication folder in the export
directory.

Related tasks
Changing protocol adjudication settings on page 13

Algorithms

This section lists details about the various algorithms that are available in
HAWS.
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Confirmation Algorithm (visit = CFM)

Figure 20: Confirmation algorithm

Confirmation

RNA PCR

Reactive?

Is RNA positive?

Propose result:
Further testing
required

Propose result:
Infected
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Table 1: CFM Algorithm - Blinded and Unblinded Report Summary

Comments
ECR (EIA/ Geenius HIV-1 HIV-1 HIV-2 HIV-2 |Unblinded CFM
CMIA/ (assay RNA TNA RNA TNA result summary
Rapid) interpretatio text
1 Non- Not required | Not Not Not Not Further testing
reactivex3 detected | detected | required | required | required. Draw
a new 10mL
EDTA whole blood
sample using
visit type “Follow-
up” (FUP).
2 Reactive x1 Negative Not Not Not Not Further testing
or2or3 detected | detected | required | required | required. Draw
a new 10mL
EDTA whole blood
sample using
visit type “Follow-
up” (FUP).
3 Reactive x1 HIV1 Not Not Not Not Further testing
or2or3 indeterminate | detected | detected | required | required | required. Draw
or HIV1 a new 10mL
positive EDTA whole blood
sample using
visit type “Follow-
up” (FUP).
4 Reactive x1 Negative, or | Detected| Not Not Not HIV-1 Infected
or2or3 required | required | required
HIV1
indeterminate,)
or HIV1
positive
5 Reactive x1 Negative, or | Not Detected | Not Not HIV-1 Infected
or2or3 detected required | required
HIV1
indeterminate)|
or HIV1
positive
6 Reactive x1 HIV2 Positive | Not Not Not Not HIV-2 Infected
or2or3 detected | required | required | required
7 Reactive x1 HIV Positive- | Not Not Detected | Not HIV-2 Infected
or2or3 Untypable detected | detected detected
8 Reactive x1 HIV Positive- | Not Not Not Detected | HIV-2 Infected
or2or3 Untypable detected | detected | detected
9 Reactive x1 HIV Positive- | petected| Not Detected | Not HIV-1 and HIV-2
or2or3 Untypable required required | Infected
10 | Reactive x1 HIV Positive- | Not Detected | Not Detected | HIV-1 and HIV-2
or2or3 Untypable detected detected Infected
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HVTN EOS Algorithm (visit = EOS)

Figure 21: HVTN EOS algorithm

HVTN EOS Algorithm
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(redraw) (redraw)

Propose result:
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Table 2: EOS Algorithm - Blinded and Unblinded Report Summary

Comments

CMIA/
Rapid)

ECR (EIA/

Geenius
(assay
interpretatia

HIV-1
RNA

HIV-1
TNA(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded EOS
result summary text

x3 + NR

1 Non-reactive

Abbott Prism

Not required

Not
required

Not
required

Not
required

Not
required

No evidence of
infection with HIV-1
or HIV-2. No evidence
of vaccine-induced
sero-reactivity or
serological cross-
reactivity.

2 Non-

reactive x3
+ Reactive
Abbott Prism

Not required

Not
required

Not
required

Not
required

Not
required

No evidence of
infection with HIV-1
or HIV-2. No evidence
of non-specific
sero-reactivity or
vaccine-induced
sero-reactivity (if
participant received
vaccine product)

by most recent
methods available.
Evidence of non-
specific or possible
vaccine-induced
sero-reactivity

by a less specific
method (Abbott Prism
HIV-1/2/0 Plus).

or2or3

3 Reactive x1

Negative

Not
Detected

Not
Detected

Not
required

Not
required

No evidence of
infection with HIV-1 or
HIV-2. These results
are consistent with
vaccine-induced
sero-reactivity, if
participant received
vaccine product, or
these results may be
due to non-specific
serological cross-
reactivity.

or2or3

4 Reactive x1

HIV1
indeterminat¢
or HIV1
positive
(consistent
with
product)

Not
Detected

Not
Detected

Not
required

Not
required

No evidence of
infection with HIV-1 or
HIV-2. These results
are consistent with
vaccine-induced
sero-reactivity, if
participant received
vaccine product, or
these results may be
due to non-specific
serological cross-
reactivity.
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ECR (EIA/ Geenius HIV-1 HIV-1 HIV-2 |HIV-2 |Unblinded EOS
CMIA/ (assay RNA TNA(or | RNA TNA result summary text
Rapid) interpretatid DNA)
5 Reactive X1 | Negative or | Detected Not Not Not Infected, HIV-1
or2or3 required | required | required
HIV1
indeterminat¢
or HIV1
positive or
HIV Positive,
Untypable
6 [Reactive X1 [ Negative Not Detected| Not Not Infected, HIV-1
or2or3 or HIV-1 detected required | required
indeterminat¢
or HIV-1
positive or
HIV Positive,
Untypable
7 Reactive x1 | HIV2 Not Not Not Not Infected, HIV-2
or2or3 Positive required | required | required | required
8 |Reactive x1 | HIV2 Not Not Detected Not Infected, HIV-2
or2or3 indeterminatq required | required required
9 | Reactive x1 | HIV2 Not Not Not Detected| Infected, HIV-2
or2or3 indeterminatq required | required | detected
10 | Reactive x1 [ HIV Positive, | Not Not Detected| Not Infected, HIV-2
or2or3 Untypable detected| detected detected
11 | Reactive x1 | HIV Positive, | Not Not Not Detected| Infected, HIV-2
or2or3 Untypable detected| detected| detected
12 | Reactive x1 HIV POSitiVe, Detected Not Detected Not Infected, HIV-1 and
or2or3 Untypable required required | HIV-2
13 | Reactive x1 | HIV Positive, | Not Detected| Not Detected| Infected, HIV-1 and
or2or3 Untypable detected detected HIV-2
14 | Reactive x1 | HIV Positive, | Detected| Not Not Detected| Infected, HIV-1 and
or2or3 Untypable required | detected HIV-2
15 | Non- Negative Not Not Not Not No evidence of
reactive x2 Detected| required | required | required | infection with HIV-1/2
+ Antigen and no evidence
reactive of vaccine-induced
Abbott seropositivity/
Determine reactivity (VISP/R).

These results (antigen
reactivity with non-
detectable RNA
results) are consistent
with non-specific
cross-reactivity (false
reactive, not VISP/R).
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Evaluation of Sero-Reactivity Recent Exposure
Algorithm (visit = EOX)

Figure 22: Evaluation of Sero-Reactivity Recent Exposure (EOX)
algorithm
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Table 3: EOX Algorithm - Blinded and Unblinded Report Summary
Comments

ECR (EIA/
CMIA/
Rapid)

Geenius
(assay
interpretati

HIV-1
RNA

HIV-1
TNA
(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded EOX result
summary text

Non-
reactive
x3 + NR
Abbott
Prism

Not
required

Not
detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.

No evidence of vaccine-
induced sero-reactivity or
non-specific serological
cross-reactivity. If

any previous HVTN

HIV diagnostic test
results showed evidence
of vaccine-induced
sero-reactivity, it is
recommended that

HIV diagnostic testing
continue through the
HVTN until no evidence
of sero-reactivity is
repeatedly demonstrated.

Non-
reactive x3
+ Reactive
Abbott
Prism

Not
required

Not
detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2. No
evidence of non-specific
sero-reactivity or vaccine-
induced sero-reactivity
(if participant received
vaccine product) by most
recent methods available.
Evidence of non-specific
or possible vaccine-
induced sero-reactivity
by a less specific method
(Abbott Prism HIV-1/2/0
Plus).

Reactive x1
or2or3

Negative

Not
Detecteq

Not
detected

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.
These results are
consistent with vaccine-
induced sero-reactivity,
if participant received
vaccine product, or these
results may be due to
non-specific serological
cross-reactivity.
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ECR (EIA/ | Geenius HIV-1 | HIV-1 | HIV-2 | HIV-2 |Unblinded EOX result
CMIA/ (assay RNA TNA RNA TNA summary text
Rapid) interpretati (or
DNA)
4 | Reactive x1 | HIv1 Not Not Not Not No evidence of infection
or2or3 indeterminate Detected detected required| required| with HIV-1 or HIV-2.
or HIV1 These results are
positive consistent with vaccine-
. induced sero-reactivity,
(consistent it . ved
with i pa_rt|C|pant receive
roduct) vaccine product, or these
P results may be due to
non-specific serological
cross-reactivity.
5 |Reactive x1 | Negative or | Detected Not Not Not Infected, HIV-1
or2or3 required| required| required
HIV1
indeterminatg
or HIV1
positive or
HIV
Positive,
Untypable
6 |[Reactive X1 [ Negative Not Detected Not Not Infected, HIV-1
or2or3 or HIV-1 detected required| required
indeterminatg
or HIV-1
positive or
HIV
Positive,
Untypable
7a | Reactive x1 | HIV2 Not Not Detected Not Infected, HIV-2
or2or3 Positive detected required required
7b | Reactive x1 | HIV2 Not Not Not Detected Infected, HIV-2
or2or3 Positive detected required| detected
8a | Reactive x1 | HIV2 Not Not Detected Not Infected, HIV-2
or2or3 indeterminatédetected required required
8b | Reactive x1 | HIV2 Not Not Not Detected Infected, HIV-2
or2or3 indeterminatedetected required| detected
9a | Reactive x1 | HIV Not Not Detected Not Infected, HIV-2
or2or3 Positive, detected detected detected
Untypable
9b | Reactive x1 | HIV Not Not Not Detected Infected, HIV-2
or2or3 Positive, detected detected detected
Untypable
10a| Reactive x1 | HIV Detected Not Detected Not Infected, HIV-1 and
or2or3 Positive, required required| HIV-2
Untypable
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ECR (EIA/ | Geenius HIV-1 | HIV-1 | HIV-2 | HIV-2 |Unblinded EOX result
CMIA/ (assay RNA TNA RNA TNA summary text
Rapid) interpretati (or
DNA)

10b| Reactive x1 | HIV Not Detected Not Detected Infected, HIV-1 and

or2or3 Positive, detected detected HIV-2
Untypable

11 [ Non- Negative Not Not Not Not No evidence of infection
reactive x2 Detected required| required| required| with HIV-1/2 and no
+ Antigen evidence of vaccine-
reactive induced seropositivity/
Abbott reactivity (VISP/R). These
Determine results (antigen reactivity

with non-detectable RNA
results) are consistent
with non-specific cross-
reactivity (false reactive,
not VISP/R).
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Vaccine Recent Exposure Algorithm (visit = EXP)

Figure 23: Vaccine Recent Exposure Algorithm
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ECR RNA DNA Pass | Proposed Algorithm Result Summary
Criteria Criteria Criteria

Non- Not Detected | Not required |1 No evidence of infection with HIV-1.
reactive,

Reactive or

Equivocal x1

ECR

Non- Detected Not required |1 Further Testing Required. Draw new
reactive, sample per protocol requirements and
Reactive or submit using visit type Redraw

Equivocal x1
ECR

Frontier Science Foundation
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mAb Recent Exposure Algorithm (visit = EXP)

Figure 24: mAb Recent Exposure Algorithm
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ECR RNA Geenius Pass | Proposed Algorithm Result Summary
Criteria Criteria Criteria

Non-reactive | Non-reactive | N/A 1 No evidence of infection with HIV-1 or
x1 ECR x1 ECR HIV-2.

Reactive or Any Any 1 Further Testing Required. Draw new
Equivocal 1x sample per protocol requirements and
ECR submit using visit type Redraw/RDW
Any Reactive or Any 1 Further Testing Required. Draw new

Equivocal 1x
ECR

sample per protocol requirements and
submit using visit type Redraw/RDW
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Follow-up Algorithm (visit = FUP)

Figure 25: Follow-up algorithm

Follow-up
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ECR
Criteria

HIV-1 RNA
Criteria

HIV-1 DNA
Criteria

Pass

Proposed Algorithm Result Summary

Non-reactive
x1

Not detected

Not detected

Blinded: No evidence of infection with
HIV-1.

Unblinded Report: No evidence of infection
with HIV-1.

If any previous HVTN HIV diagnostic

test results showed evidence of vaccine-
induced sero-reactivity, it is recommended
that HIV diagnostic testing continue
through the HVTN until no evidence of
sero-reactivity is repeatedly demonstrated.

Reactive x1

Not detected

Not detected

Blinded: No evidence of infection with
HIV-1.

Unblinded: No evidence of infection with
HIV-1. These results may be due to
vaccine-induced sero-reactivity (VISR) or
non-specific cross-reactivity.

Reactive x1

Not detected

Positive

Blinded or Unblinded: HIV-1 Infected
based on FUP and SRV or CFM lab results.

Reactive x1

Positive

Positive

Blinded or Unblinded: HIV-1 Infected
based on FUP and SRV or CFM lab results.

Infected Testing Algorithm (visit = INF)

Figure 26: Infected testing algorithm

Algorithmused forinfected protocols orinfected tracks within a

protocol

HIV-1 RNAPCR

ReportViral Load

Mote: Reportto include testing lab code and VL kit name/code
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Post-study Algorithm (visit = POS)

Figure 27: Post-study (POS) algorithm
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Table 4: POS Algorithm - Blinded and Unblinded Report Summary
Comments

ECR (EIA/
CMIA/
Rapid)

Geenius
(assay
interpretati

HIV-1
RNA

HIV-1
TNA
(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded POS result
summary text

Non-
reactive
x3 + NR
Abbott
Prism

Not
required

Not
detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.

No evidence of vaccine-
induced sero-reactivity or
non-specific serological
cross-reactivity. If

any previous HVTN

HIV diagnostic test
results showed evidence
of vaccine-induced
sero-reactivity, it is
recommended that

HIV diagnostic testing
continue through the
HVTN until no evidence
of sero-reactivity is
repeatedly demonstrated.

Non-
reactive x3
+ Reactive
Abbott
Prism

Not
required

Not
detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2. No
evidence of non-specific
sero-reactivity or vaccine-
induced sero-reactivity
(if participant received
vaccine product) by most
recent methods available.
Evidence of non-specific
or possible vaccine-
induced sero-reactivity
by a less specific method
(Abbott Prism HIV-1/2/0
Plus).

Reactive x1
or2or3

Negative

Not
Detecteq

Not
detected

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.
These results are
consistent with vaccine-
induced sero-reactivity,
if participant received
vaccine product, or these
results may be due to
non-specific serological
cross-reactivity.
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ECR (EIA/ | Geenius HIV-1 | HIV-1 | HIV-2 | HIV-2 |Unblinded POS result
CMIA/ (assay RNA TNA RNA TNA summary text
Rapid) interpretati (or
DNA)
4 [ Reactive x1 [ H1v1 Not Not Not Not No evidence of infection
or2or3 indeterminate Detected detected required| required| with HIV-1 or HIV-2.
or HIV1 These results are
positive consistent with vaccine-
. induced sero-reactivity,
(consistent it . ved
with i pa_rt|C|pant receive
roduct) vaccine product, or these
P results may be due to
non-specific serological
cross-reactivity.
5 |Reactive x1 | Negative or | Detected Not Not Not Infected, HIV-1
or2or3 required| required| required
HIV1
indeterminatg
or HIV1
positive or
HIV
Positive,
Untypable
6 |[Reactive X1 [ Negative Not Detected Not Not Infected, HIV-1
or2or3 or HIV-1 detected required| required
indeterminatg
or HIV-1
positive or
HIV
Positive,
Untypable
7a | Reactive x1 | HIV2 Not Not Detected Not Infected, HIV-2
or2or3 Positive detected required required
7b | Reactive x1 | HIV2 Not Not Not Detected Infected, HIV-2
or2or3 Positive detected required| detected
8a | Reactive x1 | HIV2 Not Not Detected Not Infected, HIV-2
or2or3 indeterminatédetected required required
8b | Reactive x1 | HIV2 Not Not Not Detected Infected, HIV-2
or2or3 indeterminatedetected required| detected
9a | Reactive x1 | HIV Not Not Detected Not Infected, HIV-2
or2or3 Positive, detected detected detected
Untypable
9b | Reactive x1 | HIV Not Not Not Detected Infected, HIV-2
or2or3 Positive, detected detected detected
Untypable
10a| Reactive x1 | HIV Detected Not Detected Not Infected, HIV-1 and
or2or3 Positive, required required| HIV-2
Untypable
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ECR (EIA/ | Geenius HIV-1 | HIV-1 | HIV-2 | HIV-2 |Unblinded POS result
CMIA/ (assay RNA TNA RNA TNA summary text
Rapid) interpretati (or
DNA)

10b| Reactive x1 | HIV Not Detected Not Detected Infected, HIV-1 and

or2or3 Positive, detected detected HIV-2
Untypable

11 [ Non- Negative Not Not Not Not No evidence of infection
reactive x2 Detected required| required| required| with HIV-1/2 and no
+ Antigen evidence of vaccine-
reactive induced seropositivity/
Abbott reactivity (VISP/R). These
Determine results (antigen reactivity

with non-detectable RNA
results) are consistent
with non-specific cross-
reactivity (false reactive,
not VISP/R).

Retrospective Algorithm (visit = RRV)

Figure 28: Retrospective (RRV) algorithm

Internal algorithm usedforretrospective viralload testingif required by the protocol.
Viralloads will be ordered on previous visit specimensuntila “RNA Not Detected” result
is obtained. Results are not reportedto clinic..

HIV-1 RNAPCR

Exportresults to
SCHARP; Site reports
are not generated.
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Post-study Testing Service Algorithm (visit =
SRV)

Figure 29: Post study testing service (SRV) algorithm
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Table 5: SRV Algorithm - Blinded and Unblinded Report Summary
Comments

ECR (EIA/
CMIA/
Rapid)

Geenius
(assay
interpretati

HIV-1
RNA

HIV-1
TNA
(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded SRV result
summary text

Non-
reactivex3

+ NR
Abbott
Prism

Not
required

Not
detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.

No evidence of vaccine-
induced sero-reactivity or
non-specific serological
cross-reactivity. If

any previous HVTN

HIV diagnostic test
results showed evidence
of vaccine-induced
sero-reactivity, it is
recommended that

HIV diagnostic testing
continue through the
HVTN until no evidence
of sero-reactivity is
repeatedly demonstrated.

Non-
reactivex3

+ Reactive
Abbott
Prism

Not
required

Not
detected

Not

required

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2. No
evidence of non-specific
sero-reactivity or vaccine-
induced sero-reactivity
(if participant received
vaccine product) by most
recent methods available.
Evidence of non-specific
or possible vaccine-
induced sero-reactivity
by a less specific method
(Abbott Prism HIV-1/2/0
Plus).

3a
PrE
yes

Reactive x1
Por 2 or 3

Negative

Not
Detecteq

Not
detected

Not
required

Not
required

No evidence of infection
with HIV-1 or HIV-2.
These results are
consistent with vaccine-
induced sero-reactivity,
if participant received
vaccine product, or these
results may be due to
non-specific serological
cross-reactivity.
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ECR (EIA/ | Geenius HIV-1 | HIV-1 |HIV-2 | HIV-2 |Unblinded SRV resuit
CMIA/ (assay RNA TNA RNA TNA summary text
Rapid) interpretati (or
DNA)
3b | Reactive x1 | Negative Not Not Not Not No evidence of infection
PrE jor 2 or3 Detected required| required| required| with HIV-1 or HIV-2.
r These results are
no . - .
consistent with vaccine-
induced sero-reactivity,
if participant received
vaccine product, or these
results may be due to
non-specific serological
cross-reactivity.
4 | Reactive x1 | HIv1 Not Not Not Not No evidence of infection
or2or3 indeterminate Detected detected required| required| with HIV-1 or HIV-2.
or HIV1 These results are
positive consistent with vaccine-
induced sero-reactivity,
if participant received
vaccine product, or these
results may be due to
non-specific serological
cross-reactivity.
5 [Reactive x1 | Negative, or | Detected Not Not Not Presumptive HIV-1
or2or3 required| required| required| Infected, based on a
HIVl . single blood specimen.
indeterminate, Recommend further
or HIV1 testing for confirmation.
positive Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM".
6 | Reactive X1 | Negative, or | Not Detected Not Not Presumptive HIV-1
or2or3 Detected required| required| Infected, based on a
HIVl . single blood specimen.
indeterminatg, Recommend further
or ",'I_Vl testing for confirmation.
positive Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM”.
7 | Reactive x1 | HIV2 Not Not Not Not Presumptive HIV-2
or2or3 Positive detected required| required| required| Infected, based on a

single blood specimen.
Recommend further
testing for confirmation.
Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM”.
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ECR (EIA/
CMIA/
Rapid)

Geenius
(assay
interpretati

HIV-1
RNA

HIV-1
TNA
(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded SRV resuit
summary text

Reactive x1
or2or3

HIV
Positive-
Untypable

Not
detected

Not
detected

Detecteq

Not
detected

Presumptive HIV-2
Infected, based on a
single blood specimen.
Recommend further
testing for confirmation.
Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM".

Reactive x1
or2or3

HIV
Positive-
Untypable

Not
detected

Not
detected

Not
detected

Detecteq

Presumptive HIV-2
Infected, based on a
single blood specimen.
Recommend further
testing for confirmation.
Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM".

10

Reactive x1
or2or3

HIV
Positive-
Untypable

Detecteq

Not
required

Detecteq

Not
required

Presumptive HIV-1 and
HIV-2 Infected, based on
a single blood specimen.
Recommend further
testing for confirmation.
Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM".

11

Reactive x1
or2or3

HIV
Positive-
Untypable

Not
detected

Detecteq

Not
detected

Detecteq

Presumptive HIV-1 and
HIV-2 Infected, based on
a single blood specimen.
Recommend further
testing for confirmation.
Please draw a new
sample per service
testing requirements and
submit using visit type
“Confirmation/CFM”.

12

Non-
reactive x2
+ Antigen
reactive
Abbott
Determine

Negative

Not
Detected

Not
required

Not
required

Not
required

No evidence of infection
with HIV-1/2 and no
evidence of vaccine-
induced seropositivity/
reactivity (VISP/R). These
results (antigen reactivity
with non-detectable RNA
results) are consistent
with non-specific cross-
reactivity (false reactive,
not VISP/R).
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Vaccine Routine algorithm (visit = VST)

Figure 30: Vaccine Routine algorithm
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ECR RNA DNA Pass | Proposed Algorithm Result Summary
Criteria Criteria Criteria

Non-reactive | Not Required | Not Required | 1 No evidence of infection with HIV-1.

x1 ECR

Reactive or Not Detected | Not Required | 1

Equivocal x1 No evidence of infection with HIV-1.

ECR

Reactive or Detected Not Required | 1 Further Testing Required. Draw new

Equivocal x1
ECR

sample per protocol requirements and
submit using visit type “Redraw/RDW"
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mAb Routine Algorithm (visit = VST)

Figure 31: mAb Routine algorithm
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ECR RNA DNA Pass | Proposed Algorithm Result Summary
Criteria Criteria Criteria

Non-reactive | Not required | Not required |1 No evidence of infection with HIV-1 or
x1 ECR HIV-2.

Reactive or Not required | Not required |1 Further Testing Required. Draw new
Equivocal 1x sample per protocol requirements and
ECR submit using visit type Redraw/RDW

Minimal Post-Study Algorithm

Figure 32: Minimal Post-Study Algorithm
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Table 6: Minimal Post-Study Algorithm - Unblinded Report Summary

Comments

ECR (EIA/

CMIA/Rapid)

Geenius (assay
interpretation)

HIV-1
RNA

HIV-1
TNA

(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded
POS result
summary
text

ECR

1 | Non-reactive x3

Not required

Not
detected

Not
required

Not
required

Not
required

No evidence
of infection
with HIV-1

or HIV-2.

No evidence
of vaccine-
induced sero-
reactivity or
non-specific
serological
Cross-
reactivity. If
any previous
HVTN HIV
diagnostic
test results
showed
evidence

of vaccine-
induced sero-
reactivity, it is
recommended
that HIV
diagnostic
testing
continue
through the
HVTN until no
evidence of
sero-reactivity
is repeatedly
demonstrated.

or 3

2 | Reactive x1 or 2

Negative

Not
detected

Not
detected

Not
required

Not
required

No evidence
of infection
with HIV-1 or
HIV-2. These
results are
consistent
with vaccine-
induced sero-
reactivity, if
participant
received
vaccine
product, or
these results
may be due to
non-specific
serological
cross-
reactivity.
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ECR (EIA/ Geenius (assay |HIV-1 |HIV-1 HIV-2 | HIV-2 Unblinded
CMIA/Rapid) interpretation) | RNA TNA RNA TNA POS result
summary
(or text
DNA)
3 | Reactive x1 or 2 | HIV-1 Not Not Not Not No evidence
or3 Indeterminate or | detected detected | required| required | of infection
HIV-1 Positive with HIV-1 or
(consistent with HIV-|2. These
product) resu_ts are
consistent
with vaccine-
induced sero-
reactivity, if
participant
received
vaccine
product, or
these results
may be due to
non-specific
serological
cross-
reactivity.
4 [ Reactive x1 or 2 | Negative or Detected Not Not Not Infected,
or 3 required | required| required | HIV-1
HIV-1
Indeterminate or
HIV-1 Positive or
HIV Positive,
Untypable
5 | Reactive x1 or 2 | Negative or HIV-1 | Not Detected| Not Not Infected,
or 3 Indeterminate or | detected required| required | HIV-1
HIV-1 Positive or
HIV Positive,
Untypable
64 Reactive x1 or 2 | HIV-2 Positive Not Not Detecteq Not Infected,
or3 detected required required | HIV-2
6 Reactive x1 or 2 | HIV-2 Positive Not Not Not Detected | Infected,
or3 detected required | detected HIV-2
749 Reactive x1 or 2 | HIV-2 Not Not Detected Not Infected,
or 3 Indeterminate detected required required [ HIV-2
7H Reactive x1 or 2 | HIV-2 Not Not Not Detected | Infected,
or3 Indeterminate detected required | detected HIV-2
84 Reactive x1 or 2 | HIV Positive, Not Not Detected Not Infected,
or3 Untypable detected detected detected | HIV-2
84 Reactive x1 or 2 | HIV Positive, Not Not Not Detected | Infected,
or3 Untypable detected detected | detected HIV-2
99 Reactive x1 or 2 | HIV Positive, Detecteq Not Detecteq Not Infected,
or3 Untypable required required |[HIV-1 and
HIV-2
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ECR (EIA/
CMIA/Rapid)

Geenius (assay
interpretation)

HIV-1
RNA

HIV-1
TNA

(or
DNA)

HIV-2
RNA

HIV-2
TNA

Unblinded
POS resulit
summary
text

94 Reactive x1 or 2

or 3

HIV Positive,
Untypable

Not
detected

Detected

Not
detected

Detected

Infected,
HIV-1 and
HIV-2

1(d Non-reactive
X2 + Antigen
reactive Abbott

Determine

Negative

Not
Detecteq

Not
required

Not
required

Not
required

No evidence
of infection
with HIV-1/2
and no
evidence

of vaccine-
induced
seropositivity/
reactivity
(VISP/R).
These results
(antigen
reactivity
with non-
detectable
RNA results)
are consistent
with non-
specific cross-
reactivity
(false
reactive, not
VISP/R).

Criteria

Result

RNA is Detected

Standard redraw is triggered (SubmitRedraw,
ReceiveRedraw, EIA, Geenius, RNA PCR)

EIA is Reactive

Geenius is triggered

EIA 2 or 3 are Reactive

Geenius is triggered

EIA is Non-reactive

EIA 2 and EIA 3 tests are triggered

RNA was positive and a redraw was triggered

HAWS will propose no result

All EIAs were Non-reactive

HAWS will propose Uninfected with no
evidence of VISP

At least one EIA was Reactive

HAWS will propose Uninfected, likely VISP
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Open Discretionary Algorithm

Figure 33: Open Discretionary Algorithm

Open Discretionary

User-Defined
Discretionary Tests

Propose Result:
None

The Open Discretionary Algorithm does not automatically order any tests. This
workflow allows the user to manually add any discretionary tests or redraws
that they require before setting a final result and generating a final report.

Blinded and Unblinded Report Summary Results:

¢ No evidence of infection with HIV-1

¢ No evidence of infection with HIV-2

¢ No evidence of infection with HIV-1 or HIV-2
e HIV-1 Infected

e HIV-2 Infected

e HIV-1 and HIV-2 Infected

e Inconclusive

Glossary of terms

final report task
Task for generating the final workflow report after a workflow is completed.
Also known as: Report

process assay task
Workflow task for entering assay results
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Also known as: ProcessAssay

receive redraw task

Process a specimen that has been redrawn by selecting the specimen from a
new visit.

reassign specimen for a test
Change the specimen assigned to be tested on an assay.
Also known as: ResultAlgorithm

review assay task
Workflow task for reviewing and approving assay runs

select sample task
Workflow task for selecting the specimen to be tested.
Also known as: SelectSample

submit redraw task

Workflow task for initiating the redraw of a specimen, such as when the final
result is QNS.

Revision history

Manual HAWS Date Summary
Version Version

- 7.0.0 2024-01-05 HAWS 7.0 updates. Updates throughout to
reflect the fact that HAWS is able to sync with
web LDMS data. Added Open Discretionary
Algorithm and Evaluation of Sero-Reactivity
Recent Exposure (EOX) algorithm. Added new
assay kits to the following assays: Alere, DNA
PCR, EIA, HIV RNA PCR. Added result option
“Inconclusive” to Geenius test. Updated DNA
PCR result option "Positive" to "Detected" and
"Negative" to "Not Detected".

- 6.4.0 2022-05-16 Added "Minimal Post-Study Algorithm -
Unblinded Report Summary Comments" table
to Minimal Post-Study algorithm section

- 6.4.0 2022-01-18 Added new section in Algorithms - Minimal
Post-Study Algorithm

- 6.3.0 2021-02-16 Updated "Location Administration" section

- 6.2.0 2020-11-07 Updated "Backup Management" section;

updated "Supported Assays" section to include
"SD Bioline EIA test" kit and "Determine HIV
Early Detect" Alere kit

Frontier Science Foundation 85



LS.0007 | HAWS User Manual

Manual HAWS Date Summary

Version Version

- 6.1.0 2020-05-06 Added option to "Adding a Discretionary
Redraw to a Workflow" section about whether
the ECR/Geenius/RNA PCR tests should be
automatically created

- 6.0.0 2019-10-01 Clinic UI screen updated; added "alere HIV
Combo" as new kit; algorithm diagrams and
charts updated

- 5.5.0 2019-03-12 Removed erroneously included section; fixed
algorithm descriptions

- 5.5.0 2018-11-01 Updated remainder of algorithms to newer
style; Updated available reports and assays
sections

- 5.4.0 2018-07-10 HAWS 5.4 updates
e Routine algorithm for AMP protocols
e Recent exposure/acute infection algorithm

for AMP protocols

e Redraw algorithm phase for AMP protocols

- 5.3.0 2018-03-23 HAWS 5.3 updates

- 5.2.1 2017-09-19 HAWS 5.2.1 hotfix updates

- 5.1 2017-05-31 HAWS 5.1 updates

- 5.0 2017-03-10 HAWS 5.0 updates
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de-approving results 37
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do not export 29, 48

do not report 48

EIA assay 7, 29, 33, 38

EOS algorithm 12, 45, 56

Evaluation of seroreactivity 56

EXP algorithm 12, 45, 63, 65

exporting 11, 44, 48

extra test info in assay results option 29

F

final report
printing multiple 43, 50
final report task 23, 43, 47
final result 33, 33, 33, 35, 35, 36, 37, 39
final workflow report 43
final workflow result 33, 40, 48
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FUP algorithm 67
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Geenius 32

H

HAWS 5

HAWS User Support 6, 7

HIV-1 Total Nucleic Acid Assay 35
holiday administration 18
HPTNO85 65, 79

HVTN 5

HVTN 703 65, 79

HVTN704 65, 79

I

inactive user 8, 10

INF algorithm 12, 44, 68
infected testing 68
initials 9

installation 6

invalid result 37
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LDMS 5, 6, 7, 15, 23, 40
location administration 17

manage runs task 23, 28, 28, 29, 38
Multi-Spot assay 7, 29, 35

never store 11
NPTNO81 65, 79

o

OD 33
open discretionary assay 35
Options window 6, 11, 22

P

password 9
patient
unblinding 12, 15
permissions 10
POS algorithm 12, 45, 69
post study 69
post-study follow-up 67
post-study testing service 73
process assay task 23, 44
protocol
adjudication settings 13
unblinding 12, 14
protocol administration 12, 13, 14, 15

Q

QNS 33, 39

R

reassign specimen for a test task 23, 27
receive redraw task 23, 40, 48
recent exposure 63, 65

redraaw specimens 48

redraw specimen 23, 40, 45
refresh from LDMS 6

reports 28, 29, 48, 51, 52
reports directory 11, 50

require adjudication 13

result algorithm task 23, 40, 43
result algorithm workflow task 47
results 29, 37

retrospective algorithm 72
review assay task 23

RNA PCR assay 7, 29, 36

routine algorithm 77, 79

RRV algorithm 44, 72

run management task 29

Run Worksheet Report 28, 29, 29

S

S/SO 33
SAP Crystal Reports Report Viewer 39,
43, 50
SCHARP 15, 51
select sample task 23, 27, 40, 44
select smaple task 26
specimen
adding to HAWS 26
codes 26
Specimen Locator Report 28, 29, 29
SRV algorithm 73
storage administration 15
submit redraw task 23, 39, 40, 45, 48
support 7
system administrator 15
system administrators 8, 9, 10

T

tasks 23

test now location 15, 26
TNA assay 35

Total Nucleic Acid Assay 35
turn around time 18, 48

U

unblinded reports 12, 51

unblinding 14, 15

user can approve results permission 8, 9,
37,40

user can view and print reports
permission 8, 9, 50, 51

users 8, 9, 10

\'}

view all workflows task 23, 40, 43, 47
visit unit 24
VST algorithm 12, 45, 77, 79

w
Western Blot assays 7, 29, 37
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closing 48
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